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Introduction

This document describes Spycer, the innovative data and content man-
agement application developed by DVS. It is a software program capa-
ble of handling large amounts of video data and their corresponding 
metadata, providing users with integrated browse, search and manage-
ment tools to retrieve data and gather information about them locally 
as well as via a network.

The video and film post production industry often deals with massive 
amounts of data stored on centralized storages or circulating on client 
stations. For most projects it is a challenge to keep track of the different 
shots and takes during the various production stages. With Spycer you 
can easily maintain transparency and control over video and audio data 
and their corresponding metadata. Accompanied by a conclusive rights 
management, browsing, searching and viewing of video and audio ma-
terial can be done without any difficulty and metadata, even in DPX file 
headers, can be added and edited effortlessly. Several management 
tools supplement the usage of Spycer comprising, for example, a re-
naming function for image sequences, an integrated high-speed copy-
ing process and a sophisticated defragmentation of image sequences.

All the above said can be achieved on the respective computer system 
locally with one Spycer alone, but the real benefit comes when several 
Spycer applications operate combined in a network. Then they form the 
SpycerNet, a scalable distributed content management network for 
data search and retrieval. For example, the instant a Spycer application 
detects new clips on its local storage (the watched folders) they and 
their metadata are made available to all other Spycer applications 
present in the network immediately. Furthermore, to perform manage-
ment tasks such as a defragmentation or a copying your Spycer may be 
controlled by other Spycer applications or you may control others avail-
able in the SpycerNet. Of course, all these behaviors can be fully con-
figured via rights management.

Spycer can be run on a standard computer system and does not require 
any special DVS hardware. On several DVS video systems, such as 
CLIPSTER or the Pronto2K.2, it is already integrated in the respective 
DVS software and accessible the same way as the other software mod-
ules, e.g. the Edit Tool.



1-2

Spycer User Guide

There are several different variants of Spycer available, from Spycer Ba-
sic providing a limited feature set to Spycer for DVS-SAN able to access 
storages in the StorNext file system (SNFS). For further information 
about the different variants please refer to section “Program Variants of 
Spycer” on page 1-5.

1.1 Overview

This user guide informs you about the installation and general handling 
of Spycer as well as about its complete controllable interface. The chap-
ters in this user guide contain the following information:

Chapter 1 Begins with a short introduction to Spycer, fol-
lowed by a note regarding the audience this 
manual is written for and an explanation of the 
conventions used in this manual. Furthermore, 
it details the new features, the available soft-
ware variants and their respective capabilities, 
as well as the system requirements necessary to 
run Spycer when it is not already installed.

Chapter 2 This chapter provides basic information about 
Spycer. First the key features of Spycer are de-
scribed, followed by some background infor-
mation regarding the software structure of 
Spycer and license issues.

Chapter 3 Describes the first steps to get started with 
Spycer. In this chapter you can find details 
about how to install the program, how to per-
form its first setup as well as about how to start 
and end it. This is complemented by a first 
overview of the user interface of Spycer as well 
as information about the program variant inte-
grated in the DVS software on a DVS video sys-
tem, such as CLIPSTER or the Pronto2K.2.

Chapter 4 Explains the browse and search tools of Spycer.

Chapter 5 Provides a description where and how to pre-
view data in the software.

Chapter 6 This chapter explains how to work with meta-
data, i.e. how to view and how to edit them.
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1.2 Target Group

To use this user guide and Spycer correctly you should have experience 
handling PCs and working with the respective operating system where 
Spycer is installed. For the full use of the software it would be best to 
have some knowledge in the field of digital video and its accompanying 
metadata.

1.3 Conventions Used in this User Guide

The following typographical conventions will be used in this documen-
tation:

Texts preceded by this symbol describe activities that you must per-
form in the order indicated.

– Texts preceded by this symbol are parts of a list.

Chapter 7 Describes the tools and instruments that help 
you to manage vast amounts of data with 
Spycer, such as the renaming of image se-
quences, the built-in defragmenter and the cal-
culator. Furthermore, this chapter provides 
information about the job list and scheduler of 
Spycer.

Chapter 8 Details other items of the software, such as the 
configuration settings available for Spycer or 
the options provided by its menu bar.

Appendix Gives additional information about the soft-
ware. Among others you can find here a list of 
the directly supported file formats and trouble-
shooting issues.

Index This chapter facilitates the search for specific 
terms.

Texts preceded by this symbol are general notes intended to fa-
cilitate work and help avoid errors.

You must pay particular attention to text that follows this 
symbol to avoid errors.

“ ” Texts enclosed by quotation marks are references to other man-
uals, guides, chapters, or sections.
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Keyboard Shortcuts

To perform options or procedures with the keyboard often requires si-
multaneous pressing of two keys.

Example:

Screenshots

The screenshots shown in this documentation have been taken for the 
most part from the Windows-based version of Spycer in its standard 
stand-alone application variant providing a full feature set (SAN access 
included). Depending on the software variant available to you and the 
installed operating system, your Spycer application may look different 
and/or may not provide all the features described here. However, due 
to the fact that the descriptions given here and their screenshots are 
complete, they will contain the interface items that concern your vari-
ant and/or operating system as well.

’Window’ Text in bold with single quotation marks indi-
cates a window name

BUTTON Text in small caps and bold indicates push but-
tons

Group/Menu Text in italic and bold indicates either a group 
name, menu name or options in a menu list

Menu » Option In the specified group or menu select the stated 
item

Item Text in bold only stands for other labeled items 
of the user interface

File Directory structure or file

Entry Parameters, selections or entries made in the 
program, or commands entered at a prompt

[Key] An individual key or a key combination on a 
keyboard

[Ctrl + F1] If this is given, hold down the [Ctrl] key and 
press simultaneously the [F1] key.
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1.4 Program Variants of Spycer

Spycer is available in several different program variants, from Spycer 
Basic providing a limited feature set to Spycer for DVS-SAN able to ac-
cess storages in the StorNext file system (SNFS). This section details the 
available variants, their differences and their capabilities.

The following lists the available variants:

The stand-alone variants Spycer Basic and Spycer are the same 
application differing only in their licensed features. To run a 
Spycer Basic as Spycer you need an appropriate license provid-
ed by a dongle. See section “License Issues” on page 2-11 for 
further details about the dongle and licenses.

Spycer Basic ’Spycer Basic’ is available for free. Compared to 
the other program variants it provides a limited 
feature set (see table 1-1 on page 1-6). Together 
with Spycer it is the stand-alone application that 
can be run on a standard computer system (see 
section “System Requirements” on page 1-7).

Spycer ’Spycer’ is the standard version of the Spycer ap-
plication. It is the stand-alone application that can 
be run on a standard computer system (see sec-
tion “System Requirements” on page 1-7). It pro-
vides the complete feature set with the exception 
that it cannot perform a file management or scan-
ning of data on storages in the StorNext file sys-
tem (SNFS).

integrated Spycer This variant of Spycer is integrated in the DVS 
software running on a video system by DVS (such 
as CLIPSTER or the Pronto2K.2). As the standard 
variant of Spycer (’Spycer’) it provides the com-
plete feature set and, furthermore, works seam-
lessly together with the available DVS products 
(see section “The Integrated Spycer” on 
page 3-18).

Spycer for 
DVS-SAN

This Spycer application variant can be found on 
SAN systems. Compared to the standard variant 
of Spycer (’Spycer’) it is also capable of managing 
and scanning data on storages in the StorNext file 
system (SNFS).

SpycerBox (for 
DVS-SAN)

This Spycer application variant is a special version 
for the SpycerBox system by DVS. It provides pre-
view proxies of a connected SAN system for 
downloads to other Spycers in the SpycerNet.
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The next table details the features of the different Spycer application 
variants:

Table 1-1: Features of the program variants

Spycer 
Basic

Spycer
integrated 

Spycer
Spycer for 
DVS-SAN

SpycerBox (for 
DVS-SAN)

Requirements 
dongle or 

floating license
DVS 

hardware
dongle and 
DVS-SAN

SpycerBox 
hardware

Local and SpycerNet 
browsing/searching 

X X X X X

Watch folders on 
SAN volumes 

X X

Remote control this 
Spycer via SpycerNet 

X X X X

Remote control other 
Spycer applications 
via SpycerNet 

X X X X

Renaming of image 
sequences 

X
(not on SAN)

X
(not on SAN)

X X

Editing of metadata 
X

(not on SAN)
X

(not on SAN)
X X

Built-in defragmenter 
X

(not on SAN)
X

(not on SAN)
X X

High-speed copying X X X X

File format converter X X X X

Job scheduler X X X X

Generation of pre-
view proxy clips 

X X X X

This user guide describes all possible features that a Spycer ap-
plication may provide, thus covering all above mentioned vari-
ants. The feature set of Spycer Basic is limited as detailed 
above. However, because the descriptions given here are com-
plete, its functions are explained as well. In case one feature is 
available for a particular variant only, it will be explicitly men-
tioned in the text.
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1.5 System Requirements

The stand-alone application of Spycer (’Spycer Basic’ and ’Spycer’, see 
section “Program Variants of Spycer” on page 1-5) is able to run on a 
standard computer system that fulfills the following system require-
ments:

Supported Hardware

These are the minimum hardware requirements that the computer sys-
tem has to meet if you want to use the program:

– 2 GHz processor recommended
– 512 MB of RAM
– 50 MB free space on system disk
– CD-ROM drive
– Graphic card (minimum resolution 1024 × 768)
– Network card to communicate between Spycer applications 

(SpycerNet)
– FC card to connect to a SAN (if required)

Supported Operating Systems

The program can be executed on the following operating systems:

– Linux (SUSE Linux Enterprise Server 10 or SUSE Linux Enterprise 
Desktop 10)

– Mac OS X
– Windows 2000, Windows Server 2003, Windows XP (recom-

mended), or Windows Vista

Other Requirements

The following other requirements may be necessary to run Spycer:

– Mac/Windows only: QuickTime Version 7.1.0 or higher to display 
*.mov files

– Mac/Windows only: QuickTime plug-in for DNxHD content in 
*.mov files

To run a Spycer Basic as Spycer without floating licenses you 
will also need one free USB port for the dongle to enable the 
licensed feature set. See section “License Issues” on page 2-11 
for further details about the dongle and licenses.

Be sure that you have installed the newest service packs and/
or patches for your system, otherwise you may encounter soft- 
and/or hardware problems.

DVS tested Spycer with the above mentioned Linux distribu-
tions. Others may work as well, but not necessarily.
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– License to run the program with a licensed feature set (dongle or 
floating license, see section “License Issues” on page 2-11)

1.6 Important Notes

Please observe the following when using the Spycer application:

The following network ports have to be free and available to 
connect successfully to the SpycerNet:

– Port 9960 UDP
– Port 9961 TCP
– Port 9970 UDP
– Port 9971 TCP
– Port 9980 TCP
– Port 9981 TCP
– Port 9983 TCP

See to it that these ports are free in your network (e.g. as ex-
ceptions in the firewall settings) otherwise Spycer will be con-
fined to its localhost only (IP address 127.0.0.1 has to be used). 
During the installation of a Spycer for Windows these ports are 
automatically freed. On other operating systems you may have 
to configure them manually. In case of problems or questions 
please contact your local network administrator.

The SpycerAgent registers all data (even unknown files) as well 
as all events that take place in the watched folders. To minimize 
the size of its database and the overall traffic for the Spycer-
Agent it is recommended to include directories/drives that con-
tain files of formats supported by Spycer only (see section 
“Supported File Formats” on page A-5). Otherwise search, 
scanning and defragment processes may get lengthy due to 
unnecessary overhead.

An editing of header metadata such as image related data 
(e.g. bit depth or number of pixels/lines) may lead to impaired 
material that cannot be used correctly in another application 
or Spycer anymore. When editing metadata be sure about 
what you are doing.

To run Spycer successfully under the Windows Vista operating 
system please see section “Troubleshooting under Windows 
Vista” on page A-4.

To use floating licenses the CodeMeter application has to be in-
stalled on all participating systems, i.e. on the system that dis-
tributes the licences and the system that should receive one.
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1.7 New in Spycer

The following lists the most important features and functions that were 
new in the latest Spycer versions:

New in Spycer Version 1.3

– The SpycerAgent now treats all files locally stored as potential 
sequence files, meaning the file sequence type settings were 
inverted: They now determine the file formats that should not be 
displayed as file sequences even if their file names are identical and 
contain a numbering.

– High-speed data transfers can be achieved on the local system by 
selecting additional network connections that should be used for 
data transfer tasks exclusively.

– A job scheduler allowing you to carry out various tasks automati-
cally at certain times or intervals.

– Local 3D LUT files can be viewed and local audio data can be 
played in the preview area.

– Timecode, keycode or frames information can be displayed for 
video clips in the overlay of the preview area.

– In the search tool file paths can be searched (performs a search in 
directory names). Also used by the new menu option Show all 
content on the context menu of a directory in the directory tree.

– The name of the home system as it should appear in the SpycerNet 
can be configured freely.

– Some Spycer features can be controlled from a command line (start, 
copy, move, delete, defrag).

New in Spycer Version 1.2

– Spycer displays all files stored in the watched folders, even files of 
unknown formats, and to each file separate production metadata 
can be added.

– New and enhanced icons to indicate systems, drives, directories and 
files (e.g. one icon shows systems in the SpycerNet where older 
Spycer versions are running).

– Copying of data within the SpycerNet, even between peers with 
different operating systems.

– Files can be loaded in other applications from the browse and 
search area.

– File format converter for image files and video clips.
– To locate files after a search more easily, they can be shown directly 

in the directory tree of the browse tool.

Please note that file related tasks or further information due to 
new features may not be available on systems with older Spyc-
er versions, even if triggered from a newer application version 
in the SpycerNet.
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– It can be configured which file formats to display as video clips (i.e. 
as image sequences showing one file entry in Spycer only).

– Preview area with integrated media player for video clips.
– For a real-time preview of clips, proxy clips can be generated of the 

available material. When viewing clips over the SpycerNet, the 
proxies will be temporarily downloaded from the other system.

– Enhanced properties dialog for peers as well as volumes and con-
tent.
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Basics

This chapter provides basic information about Spycer. First descriptions 
of the key features of Spycer are given. This is followed by some back-
ground information about the software structure providing details 
about the user interface, the SpycerNet and the SpycerAgent in partic-
ular. The chapter will be concluded with details and explanations of 
some license issues regarding Spycer.
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2.1 Key Features of Spycer

Spycer is a software program for content management especially de-
signed for the needs of the Digital Intermediate post production. It is 
capable of handling large amounts of video and audio data as well as 
their corresponding metadata, either locally stored or distributed on 
several systems connected to a network. Additionally, Spycer is 
equipped with powerful tools such as a high-speed copying and a so-
phisticated defragmenter. The following lists and explains shortly the 
key features of Spycer:

Browse and Search

With Spycer you can browse local or network storages via the Spycer-
Net. It offers you two browsing panes where you can browse for data 
and perform move/copy procedures between different directories eas-
ily via drag and drop. With its search tool you can find the desired ma-
terial swiftly by combining various parameters, such as file names or 
metadata information. All material and data displayed in the browse 
and search area can be shown either in text information or thumbnail 
view.

Viewing of Material

You can preview any material without difficulty in Spycer. Video clips 
and images can be viewed either with their thumbnails in the browse 
and search area or, when double-clicked, in the enlarged preview area. 
Both, the thumbnails as well as the preview area, provide a scrub bar 
(timeline) where you can move to different positions within a video 
clip’s sequence. Once video material is available in the preview area, 
you may also use the built-in media player for a real-time viewing (re-
quires a proxy) or gather further information about it in the metadata 
area. Additionally, local 3D LUT files can be viewed and local audio data 
can be played in the preview area as well. However, other files than 
these can be selected and may provide information in Spycer as well: 
For example, when a project file of a DVS video system software is sin-
gled out, you can see the media files that are used in the project’s time-
line as a list among the metadata information in the metadata area.

Adding and Editing Metadata

After data is selected and shown in the preview area, its metadata, such 
as the header data or production information, are displayed as well. 
Then they can be added or changed easily. The background process of 
Spycer enabling the local content management also administers the 

There are several variants of Spycer available. Further informa-
tion about them can be found in section “Program Variants of 
Spycer” on page 1-5.
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metadata and alters the file header(s) and/or the respective data record 
of the file/sequence in its database. With them added you can after-
wards search for specific metadata with Spycer’s search tool.

Management Tools

Spycer is equipped with several management tools such as a high-
speed copying and a sophisticated defragmenter:

To copy vast amounts of video material from one storage location to 
another is often a time consuming procedure when performed with the 
standard tools of an operating system, such as a file manager. To do this 
faster DVS integrated in Spycer a high-speed copying routine which 
deals with such tasks in about four times the speed of a standard oper-
ating system copy.

The built-in defragmenter of Spycer has been designed to optimize the 
physical alignment of image sequences (video clips) on storages so that 
they are more suited for real-time operations. It defragments any other 
data available on the selected storage as well. With Spycer you can ini-
tiate a defragmentation of one or more clips/files without any difficulty.

Spycer also offers a renaming tool for image sequences, where you can 
easily change, for instance, the name prefixes, frame numbers or file 
extensions, or a file format converter allowing you to convert video and 
image data from one file format to another.

Among other useful management tools you can find also a job list de-
tailing current and past jobs performed on or by your system and a 
scheduler allowing you to run management and maintenance tasks au-
tomatically at intervals or certain times.

SpycerNet

One Spycer can perform all the above said on the computer system 
where it is installed locally. But as soon as there are several Spycer ap-
plications installed on different computers and when they are able to 
communicate with each other via a network connection, you may ac-
cess them and their data depending on the permissions for a remote ac-
cess. By communicating with each other, sharing their databases and 
enabling a remote control of the applications for management tasks 
such as copying or defragmentation, they form the SpycerNet, a scal-
able distributed content management network for data search and re-
trieval.

Rights Management

Each Spycer contains a rights management to allow other Spycer appli-
cations in the network (SpycerNet) access to its data or a remote control 
of it. For example, the browse and search permission enables others to 
take a look at your data and metadata (i.e. they have access to the da-
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tabase of the watched folders which is created and administered by the 
background process), while read and write permissions enable them to 
control your Spycer application for system specific tasks such as a copy-
ing or defragmentation.
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2.2 Software Structure

The following provides basic information about the software structure 
of the Spycer application to help you understand how the software op-
erates.

In its parts the Spycer application consists of three elements that to-
gether provide the software’s capabilities:

– the user interface,
– the SpycerAgent and
– the SpycerNet.

While the first two are software components actually installed on the 
computer, the latter is the means of communication between different 
Spycer installations in a network enabling the scalable and distributed 
content management. The following diagram shows the software 
structure and communication processes between the individual ele-
ments of Spycer applications in a SpycerNet in detail:

Figure 2-1: Overview of the software structure

The ovals in the drawing above represent the user interfaces of the 
Spycer applications, while the lines indicate the communication ways 
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on the individual clients as well as between them in the SpycerNet. It is 
of no consequence to the SpycerNet whether the software applications 
are all of the same variant of Spycer or not (see section “Program Vari-
ants of Spycer” on page 1-5).

The following sections will explain the drawing above in more detail.

2.2.1 The User Interface

With the user interface of Spycer you can view, edit and administer the 
data shown in its areas and/or tools, for example, you can browse and 
search for data or edit their metadata. It can be used to display the con-
tents that is locally available and furthermore, when operating in a 
SpycerNet, it may also show the material that is stored on other sys-
tems.

To put it in simple terms the user interface of Spycer is just a browsing 
tool where you can view data and trigger certain events that the back-
ground process SpycerAgent may execute. In case it is running without 
the background process enabled (as the bottom right Spycer in 
figure 2-1 on page 2-5 indicates), the user interface can still be used as 
a network browser in the SpycerNet to display data available on other 
systems.

For further information about the background process SpycerAgent, 
the SpycerNet and networking see the next sections.

2.2.2 SpycerAgent

To scan and display any data locally stored on your computer system 
the Spycer application installs a background process (Mac/Windows: 
service, Linux: daemon) called SpycerAgent right after the first program 
start. It will be launched in the background of the system and in the fu-
ture start automatically during the loading of the operating system.

The SpycerAgent administers a database that contains all worthwhile 
information about the contents of the watched folders (the scanned 
and indexed local storages), such as file names, storage locations, pixel 
formats, color spaces, or metadata. This database is then used in the 
user interface of Spycer to display video and audio material as well as 
all other data. By using a database to present the contents of storages 
Spycer offers you fast access to large amounts of data, for example, for 
search procedures. Once the database is created, the SpycerAgent 
monitors the watched folders, for example, for new files, deletions, re-

Because the user interface runs independently from the 
SpycerAgent it will separately check whether a valid license is 
provided. When found it will run with the respective feature set 
enabled (see section “License Issues” on page 2-11).
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namings, etc., whereupon the local database of Spycer is revised so that 
it is always up-to-date with the actual content stored.

The SpycerAgent is an important part of the SpycerNet. On the one 
hand it makes the data in the database available to the user interface 
installed locally and on the other to all other Spycer applications in the 
network (if browse and search permissions are given, see section “Re-
mote Access Permissions” on page 3-14). Without it only the data pro-
vided by other SpycerAgents in the network can be seen and accessed. 
Thus, it is the database that will be visible to other Spycer user interfac-
es in the SpycerNet.

Furthermore, the SpycerAgent controls the Spycer application tasks on 
your system such as copy or defragmentation processes. Usually, these 
are initiated by the user interfaces in the SpycerNet. Locally you can 
perform read and write as well as browse, search and edit processes as 
desired: The user interface triggers the event and the SpycerAgent car-
ries them out. Nevertheless, when operating in a SpycerNet and initiat-
ing a Spycer application task on another system, it may be denied by 
the other Spycer due to insufficient remote access permissions. Then 
the access rights have to be set accordingly on the systems where you 
want to perform the task (see section “Remote Access Permissions” on 
page 3-14).

The SpycerAgent runs totally independent of Spycer’s user interface. It 
is started automatically during the loading of the operating system and, 
when not terminated otherwise, it is stopped when the operating sys-
tem is turned off. This makes it possible to maintain the SpycerNet al-
most at all times. Even with no user logged in to the system and no 
Spycer user interface running, other Spycer user interfaces will be able 
to search and browse in your data (if permitted on your system). Copy 
or write procedures on your system initialized by other Spycer applica-
tions are possible as well and all processes are written to the database 
by the SpycerAgent soon after they occurred.

With the local content management (i.e. the SpycerAgent) enabled, 
Spycer not only displays the data scanned and indexed in its database. 
The viewing or reading of the contents of other drives or directories on 
your system (local reading) as well as of mounted network drives is pos-
sible even without their contents added to the database. The user in-
terface displays all data available when selected in its browsing pane. 

The very first writing of the database may take some time de-
pending on the amount of data stored in the watched folders.

Further information about the watched folders can be found in 
section “Watch Folder Settings” on page 3-11.

Because the SpycerAgent runs independently from the user in-
terface it will separately check whether a valid license is provid-
ed. When found it will run with the respective feature set 
enabled (see section “License Issues” on page 2-11).
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However, because the contents of these locations are not detailed in 
the database, they are read when accessed only and neither will a 
search with Spycer include these locations nor will they be visible in the 
SpycerNet. File-based tasks on these drives/directories locally per-
formed, such as copy procedures to and from these drives/directories 
or the deletion of directories or files, are also possible.

To administer the background process DVS offers you a tool especially 
designed for this purpose. Please refer to section “The SpycerAgent 
Tool” on page 8-24 for more details about this. Nevertheless, the stan-
dard operating system tools to administer background processes can be 
used as well.

2.2.3 SpycerNet

The SpycerNet is one of the main features of Spycer. It is the part of the 
software that constitutes the scalable and distributed content manage-
ment.

With a single Spycer application you can access data locally stored only. 
But if there are more than one Spycer installed on different computer 
systems connected via a network, they will form the SpycerNet. Then 
they communicate with each other and share their databases providing 
information about the data stored locally on each system. The more 
Spycer applications are installed, the more data you can gather from 
different systems. This is meant by the terms ’scalable’ and ’distributed’: 
’scalable’ because there is no limit to the number of Spycer applications 
working together and ’distributed’ because they work independently 
on separate workstations as well as provide separate databases.

This way no central server is required because the individual Spycer in-
stallations communicate with each other and share their databases as 
soon as they are present in the network and browse and search permis-
sions are given.

In the SpycerNet you will be able to use your Spycer user interface to 
access data on other systems or you may use their SpycerAgents for 
certain operations (read, write, defragment) depending on the permis-
sions assigned for a remote access. Thus you can easily maintain trans-
parency and control over all video and audio data in your post 
production workflow, even if distributed on various client stations.

To configure a Spycer application to take part in the SpycerNet an IP ad-
dress other than the local host address has to be stated in the network 
settings of Spycer (see section “General Settings” on page 3-9). For 
further information about the conditions necessary to establish a 
SpycerNet see section “Notes about Networking with Spycer” on 
page 2-9.
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2.2.4 Notes about Networking with Spycer

Newer versions of Spycer usually provide features that older applica-
tions may be missing. Due to the fact that it is the native SpycerAgent 
which performs file related tasks, it may not be possible to trigger later 
developed functions on older Spycer applications in the SpycerNet. For 
a list of what is new in this Spycer version see section “New in Spycer” 
on page 1-9.

The SpycerNet is best set up in a way that the overall workload is dis-
tributed over the client stations. If working with a central storage (e.g. 
a SAN) only one Spycer should provide the database for this storage. 
This is one of the major features of Spycer: Not every system has to scan 
the central storage but only one which will share its database in the 
SpycerNet. This will reduce the overall traffic greatly because only one 
Spycer monitors the central storage.

Furthermore, each Spycer contains a basic rights management to allow 
other Spycers in the SpycerNet access to your data or a remote control 
of the SpycerAgent installed. The permissions what other Spycers are 
allowed to do on your system (as well as all other settings mentioned 
in this section) have to be stated during the initial setup of the software 
(see section “Initial Setup of Spycer” on page 3-9). Of course, they can 
be altered at any time later without difficulty (see section “Configuring 
Spycer” on page 8-4).

Listed in the following are some basics regarding the role of your Spycer 
application in a SpycerNet:

When the local content management is disabled, i.e. the SpycerAgent 
is not installed on your system:

– Your Spycer application will not appear in the SpycerNet regardless 
of any other setting.

– Your Spycer user interface will not show any files locally stored nor 
can mounted network drives be accessed.

When the local content management is enabled:

– If set to localhost, your Spycer will not appear in the SpycerNet 
regardless of the permissions given.

– With no permissions given and when an IP address is stated other 
than the localhost address, your Spycer application will be regis-
tered in the SpycerNet but provide no data.

– With permissions given and when an IP address is stated other than 
the localhost address, your Spycer application will be registered in 

Some network ports have to be free and available to connect 
successfully to the SpycerNet. Otherwise Spycer will be con-
fined to its localhost only (IP address 127.0.0.1 has to be used). 
For further information about this please see section “Impor-
tant Notes” on page 1-8.
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the SpycerNet. Other Spycer applications can perform at least 
browse and search operations in your database.

The browse and search permissions enable others to take a look at your 
data and metadata, i.e. they have access to the database administered 
by the SpycerAgent. However, with only this permission given they 
cannot change the contents of your database nor have they a real ac-
cess to your system: They see the contents of the database only and, if 
available on your system, can download proxy clips.

With the ’Edit metadata’ permission activated you enable others in the 
SpycerNet to change metadata entries of the files in your watched fold-
ers (file headers as well as database entries). This permission includes 
the browse and search permission but still a real access to your system 
is denied.

All other permissions enable them to control your SpycerAgent for file 
related tasks such as a copying or defragmentation. This is meant by re-
mote controlling other Spycers. For moving or copying operations you 
must have at least read permission on the source system and write per-
mission on the target system. Nevertheless, real damage can only be 
done with the write permission, because with it you can, for example, 
rename file sequences or delete data.
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2.3 License Issues

On DVS video devices ex factory equipped with Spycer, such as the 
DVS-SAN, CLIPSTER or the Pronto2K.2, the Spycer application is al-
ready properly installed and licensed. Then the program can be started 
immediately.

The stand-alone application of Spycer, however, needs a special license 
provided by a dongle to run with more than the basic features. In case 
the dongle is not available or the license is invalid, the stand-alone ap-
plication runs as Spycer Basic (see section “Program Variants of Spycer” 
on page 1-5). Additionally, there is also the possibility to acquire a float-
ing license to run a dedicated number of Spycer applications on a single 
dongle.

This section details some issues that may occur when licensing Spycer.

2.3.1 The Dongle

The license for Spycer to run the Spycer application with a licensed fea-
ture set is provided via a dongle (USB stick) that has to be connected to 
a free USB port on the computer system where Spycer is to be installed 
(see section “Installing the Software” on page 3-2).

When running a local content management, it is generally recommend-
ed to plug in the dongle prior to starting the computer, which will en-
sure that the SpycerAgent operates with the licensed feature set 
enabled. Additionally, it should be left connected to the system even 
when the user interface of Spycer is not running, because otherwise 
you may disrupt SpycerNet processes running on your system (e.g. a 
defragmentation). It can be disconnected safely only when the com-
puter system is turned off. Further information about the SpycerAgent 

The license for a Spycer connected to a SAN system is provided 
by a special version of the dongle. It also has to be used as de-
scribed in the following.

You can order license(s) from DVS via the Spycer web sites 
(www.spycer.net or www.spycer.de).

Details about the license currently assigned to your Spycer ap-
plication can be found in the ’About Spycer’ window (e.g. for 
troubleshooting purposes, see section “About” on page 8-22).

http://www.spycer.net
http://www.spycer.de
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and the SpycerNet can be found in section “Software Structure” on 
page 2-5.

How to Connect the Dongle to a Running Computer

When a license is not available, for example, because the dongle is not 
connected, Spycer (the user interface as well as the background pro-
cess) will run as Spycer Basic only. To connect the dongle to the com-
puter system afterwards and run Spycer with the licensed feature set 
enabled you have to perform the following:

If running close the Spycer user interface (see section “Exiting the 
Software” on page 3-23).

Connect the dongle to a free USB port on the computer system.

Afterwards restart the Spycer user interface (see section “Starting 
the Software” on page 3-7).

The above steps are enough if a local content management is disabled 
on your system (SpycerAgent not running). However, if your Spycer ap-
plication runs with the local content management enabled, during the 
start-up of Spycer a message will appear informing you about the new 
detected license. Then you have to do the following in addition:

Follow the instructions given on the screen necessary to restart the 
SpycerAgent.

Once the SpycerAgent has started, the background process as well as 
the user interface of Spycer will run with the licensed feature set en-
abled.

How to Upgrade Spycer Basic to a Licensed Spycer

To upgrade the free version of Spycer (Spycer Basic) to a licensed ver-
sion of Spycer without floating licenses available (see section “Floating 
License” on page 2-14) you will need a dongle that provides a valid li-
cense for the application. You can order it from DVS via the Spycer web 
sites (www.spycer.net or www.spycer.de).

The user interface of Spycer and the SpycerAgent run indepen-
dently from each other. Both will check separately whether a 
valid license is provided to enable the respective feature set 
(see section “Software Structure” on page 2-5).

You can find enclosed in the delivery of the licensed version of 
Spycer a special key chain. Please fasten it to the dongle to rec-
ognize it later without difficulty as belonging to Spycer.

Mac only: Please note that in some cases your system may not 
shutdown or boot normally with the dongle plugged in. To 
solve this problem, unplug the dongle during shutdown or 
(re-)boot.

http://www.spycer.net
http://www.spycer.de
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Once you have received the dongle perform the following:

Connect the dongle to a free USB port on the computer system 
where Spycer is installed.

Next start the system and afterwards the Spycer user interface (see 
section “Starting the Software” on page 3-7).

When Spycer is started, it will run with the licensed feature set.

How to Update the License on the Dongle

The license on the dongle can be updated, for instance, to enable new 
features or change an evaluation license to a non-expiring one. For this 
you have to send a request with internal license information to DVS. In 
return you will receive an update file which has to be used to program 
the dongle with a new license. After this the dongle is updated.

To update the license on the dongle do the following in detail:

Start Spycer (see section “Starting the Software” on page 3-7).

From its menu bar (see section “Overview of the User Interface” on 
page 3-16) select Tools » License Management » Request….

This will open a message window instructing you to connect the dongle 
to the computer:

If not already the case connect the dongle to a free USB port on the 
computer system and click the button OK in the message window.

This saves the license information of the dongle to a file with the name 
SpycerLicense.WibuCmRaC (exact location will be detailed in a 
message window) and simultaneously starts your e-mail software. The 
saved information will also be added to an e-mail automatically.

Send the encrypted dongle information to DVS by doing one of the 
following:

– If you are connected to the internet send the dongle informa-
tion already added to the opened e-mail to 
dongleupdate@dvs.de, or

– copy the file SpycerLicense.WibuCmRaC to a common 
storage medium (e.g. CD-ROM) which you can then send to 
DVS per mail.

Once received, the e-mail/file will be evaluated by DVS and a license 
update file with the extension *.WibuCmRaU will be created. DVS will 
send this to you as soon as possible.

After receiving the license update file do as follows:

If your computer where Spycer is installed is already running, 
instead of the following, perform the procedure described in 
section “How to Connect the Dongle to a Running Computer” 
on page 2-12.
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Store the file on the computer where the dongle is connected.

If appropriate start Spycer and select from its menu bar Tools » 
License Management » Update….

This will open a message window instructing you to connect your don-
gle to the computer and afterwards select the update file:

If not already the case connect the dongle to the computer system 
and click the button OK in the message window.

In the opening window browse for the update file *.WibuCmRaU 
on your storage and confirm your choice with the button OPEN.

This will program the dongle with the new license which may take some 
time. Once the programming of the dongle is complete, a message will 
report this.

Close the Spycer user interface and restart it to take the changes 
into effect.

When Spycer is started once again, it will run with the new license.

2.3.2 Floating License

With a floating license you can share the license of a single dongle with 
other Spycer applications, i.e. enabling a Spycer Basic on another sys-
tem in the network to run as a licensed version of Spycer. The dongle 
provides a certain number of licenses for the sharing only and the Spyc-
er applications (user interface as well as SpycerAgent) can grab the li-
censes from the dongle when they are connecting to the SpycerNet 
(only one license per system will be assigned). As long as there are li-
censes available, each Spycer Basic registering in the SpycerNet will 
then run with the licensed feature set. Once the maximum number of 
licenses is assigned, every other Spycer Basic connecting to the network 
will run with the limited feature set only.

In case the new license is still not available, you have to reboot 
your computer with the dongle connected.

If your new license is a floating license you have to configure 
the dongle as a license server to enable a sharing of the license 
(see section “Configuring a Dongle to Run as a License Server” 
on page 2-15).
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To share the license of a dongle in the SpycerNet the dongle has to be 
configured as a license server. It will then monitor the shared licenses 
and assign them anew when available again.

How to Get a Floating License

Usually, you can order dedicated licenses and/or floating licenses from 
DVS via the Spycer web sites (www.spycer.net or www.spycer.de, see 
also section “How to Upgrade Spycer Basic to a Licensed Spycer” on 
page 2-12). However, if a dongle is already available, you can convert 
a dedicated license to a floating licence with the procedure described in 
section “How to Update the License on the Dongle” on page 2-13.

Configuring a Dongle to Run as a License Server

To enable a floating license and share the license of a dongle in the 
SpycerNet the dongle has to be configured as a license server. For this 
perform the following:

If appropriate start Spycer and select from its menu bar (see section 
“Overview of the User Interface” on page 3-16) Tools » License 
Management » License Server….

This will open the following dialog window:

Figure 2-2: License server setup

Dedicated dongles, i.e. single workstation licenses, and floating 
licenses can be used together in a SpycerNet.

To use floating licenses the CodeMeter application has to be in-
stalled on all participating systems, i.e. on the system that dis-
tributes the licenses as well as the ones that receive them (see 
section “Installing the Software” on page 3-2).

It is possible to run a dedicated dongle as a license server. 
However, then you may not be able to start your Spycer with 
the licensed feature set, because the license may already be 
grabbed by another application.

http://www.spycer.net
http://www.spycer.de
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Activate the Enable license server radio button to enable the 
license server for the connected dongle.

Confirm your selection with the OK button.

After this another message window appears asking you again whether 
you are really sure about your selection:

Confirm the setting once more with the button YES.

Next close the Spycer application and restart your system.

Once the system is rebooted, the dongle connected locally to your sys-
tem will run as a license server offering other Spycer applications licens-
es to run with the licensed feature set enabled.

How to Grab a License

Licenses are not given only to the user interface of Spycer but the 
SpycerAgent as well as soon as it is started (local content management 
enabled, see section “SpycerAgent” on page 2-6). To get one of the li-
censes provided by a dongle in the SpycerNet do as follows:

If the computer system where your Spycer application is installed is 
turned off, simply start it.

Afterwards start the Spycer user interface (see section “Starting the 
Software” on page 3-7).

During the loading of the operating system it will ask locally as well as 
in the network if there is a dongle available and whether it provides a 
license. If a license is available, it will be handed to the SpycerAgent (if 
enabled) as well as the user interface of your Spycer application.

Nevertheless, to grab a license with an operating system already run-
ning and a Spycer application registering as Spycer Basic you have to 
do the following:

If running close the Spycer user interface (see section “Exiting the 
Software” on page 3-23).

Do not enable the license server if your dongle provides 
one license (dedicated license) only. Then you may not be 
able to start your Spycer with the licensed feature set, be-
cause the license may already be assigned to another ap-
plication.

To deactivate the license server for the dongle you have to per-
form the same procedure as mentioned above with the follow-
ing exception: Instead of selecting the radio button to enable 
the server you have to activate the radio button Disable li-
cense server.
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Next restart the Spycer user interface (see section “Starting the 
Software” on page 3-7).

During the start-up the Spycer user interface will ask locally as well as 
in the network if there is a dongle available and whether it provides a 
license. If a license is available, it will be given to your user interface.

The above steps will be enough to grab a license if a local content man-
agement is disabled on the system. However, if your Spycer application 
runs with the local content management enabled, a message will ap-
pear informing you about the new detected license. Then you have to 
do the following in addition:

Follow the instructions given on the screen necessary to restart the 
SpycerAgent.

Once the SpycerAgent has started, the background process as well as 
the user interface of Spycer will run with the licensed feature set and 
the procedure to grab a license is finished.

How to Make a License Available again to the Dongle

Licenses are not given only to the user interface of Spycer but to the 
SpycerAgent as well as soon as it is started (local content management 
enabled, see section “SpycerAgent” on page 2-6). To make a license 
available again to a dongle in the network perform the following:

If running close the user interface of Spycer (see section “Exiting 
the Software” on page 3-23).

The above step will be enough to give back the license to the dongle if 
a local content management is disabled on the system. However, if your 
Spycer application runs with the local content management enabled, 
you have to do the following in addition:

With a local content management enabled on your system you 
have to stop the background process SpycerAgent as well, which 
can be done either manually, for example, with its tool (see section 
“The SpycerAgent Tool” on page 8-24) or by shutting down the 
computer system.

Once the user interface and the SpycerAgent are closed, the license of 
your Spycer application is given back to the dongle and can then be as-
signed to another Spycer connecting to the network.
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Getting Started

This chapter describes how to get started with Spycer. First the instal-
lation of the software is described, followed by details how to start the 
application. When Spycer is started for the first time, it will guide you 
through some initial configuration settings that you have to specify in 
order to run Spycer. They will be described next in this chapter. Among 
them you can find, for instance, the remote access permissions and the 
network configuration settings. The chapter will be concluded with 
some more details about the software, such as an overview of the user 
interface of Spycer, a short description of the program variant of Spycer 
integrated in the DVS software on a video system by DVS (such as 
CLIPSTER or the Pronto2K.2) as well as an explanation about how to 
exit the software.
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3.1 Installing the Software

The stand-alone application variant of Spycer able to run on a standard 
computer system (see section “Program Variants of Spycer” on 
page 1-5) has to be installed first. It is available for several operating 
systems. This section describes for each available operating system sep-
arately how to install Spycer.

3.1.1 Installation under Linux

The installation of a stand-alone Spycer for Linux operating systems 
normally requires two files:

– The CodeMeter installation file (application to recognize and 
administer the dongle) and

– the Spycer installation file.

If you are in possession of a licensed Spycer, they usually can be found 
on the enclosed CD-ROM. With a licensed Spycer it is recommended 
to install the CodeMeter application first. In case you require Spycer Ba-
sic only, you can leave out the CodeMeter installation.

CodeMeter Installation

The CodeMeter application is the application that recognizes and ad-
ministers the dongle (license). With a licensed version of Spycer it is rec-
ommended to install it first:

On some DVS video devices Spycer is already installed (e.g. on 
the DVS-SAN, CLIPSTER or the Pronto2K.2). Then you may 
skip this section and continue with section “Starting the Soft-
ware” on page 3-7.

Linux and Mac only: When downloading the Spycer installa-
tion files from the Spycer internet sites (www.spycer.net or 
www.spycer.de), they will usually be available in single archive 
files. In case you want to install Spycer as Spycer Basic, you 
need the archive file that contains the Spycer application only. 
The archive containing the CodeMeter installation (application 
to recognize and administer the dongle) will not be necessary.

The newest version of the Spycer application can be found on 
the Spycer internet site (www.spycer.net or www.spycer.de).

You can leave out the CodeMeter installation when you intend 
to run Spycer as Spycer Basic only. However, when using float-
ing licenses (see section “Floating License” on page 2-14), all 
involved systems must have the CodeMeter application in-
stalled.

http://www.spycer.net
http://www.spycer.net
http://www.spycer.de
http://www.spycer.de
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Fasten the Spycer key chain to the dongle (both are included in the 
delivery of a licensed version). With this you will be able to identify 
the dongle belonging to Spycer easily in the future.

Next, open a command line (shell) and log on to the system as root.

Then install the CodeMeter application, for example, by entering:

This installs the CodeMeter application on your computer.

Afterwards plug the dongle into a free USB port at the computer 
system (see also section “License Issues” on page 2-11).

The dongle providing the license is registered automatically by the 
CodeMeter application and you will see the dongle as an additional 
drive on your desktop. After this continue the installation with the in-
stallation of the Spycer application.

Spycer Installation

To install Spycer perform the following:

If applicable, open a command line (shell) and log on to the system 
as root.

Then install the Spycer application by entering, for example:

This installs all necessary files and libraries of Spycer on the computer 
system.

With this the installation of the software is complete and as a next step 
you have to perform its initial setup to be able to run the program. It 
has to be made when the Spycer application is started for the first time 
and can be called with a normal user account (see section “Starting the 
Software” on page 3-7 and section “Initial Setup of Spycer” on 
page 3-9).

rpm -ihv <path>/CodeMeter4<version no.>.
<OS architecture>.rpm 

rpm -ihv <path>/Spycer_<version no.>.
<OS architecture>.rpm 

Under Linux the Spycer application can usually be found in the 
system menu under the entry Audio & Video » Spycer. It can 
be deinstalled by entering rpm -e Spycer in a command 
line.

The CodeMeter application can usually be found in the system 
menu under the entry System » CodeMeter Control Center. 
It can be deinstalled by entering rpm -e CodeMeter4 in a 
command line.
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3.1.2 Installation under Mac OS

The installation of a stand-alone Spycer for the Mac operating system 
usually comes as a single archive file that contains two sets of installa-
tions:

– The CodeMeter installation (application to recognize and 
administer the dongle) and

– the Spycer installation.

If you are in possession of a licensed Spycer, it usually can be found on 
the enclosed CD-ROM. With a licensed Spycer it is recommended to in-
stall the CodeMeter application first. In case you require Spycer Basic 
only, you can leave out the CodeMeter installation.

CodeMeter Installation

The CodeMeter application is the application that recognizes and ad-
ministers the dongle (license). With a licensed version of Spycer it is rec-
ommended to install it first:

Fasten the Spycer key chain to the dongle (both are included in the 
delivery of a licensed version). With this you will be able to identify 
the dongle belonging to Spycer easily in the future.

Next, open the installation file of Spycer (Install_Spycer_ 
<version no.>_<OS>.dmg, e.g. with a double-click of the 
mouse).

This will mount the Spycer application as a volume and display its con-
tent on the screen.

From this volume open the installation file of the CodeMeter appli-
cation (CmRuntimeUser_<version no.>.dmg, e.g. with a 
double-click of the mouse).

This as well will mount the CodeMeter application as a volume and dis-
play its content on the screen.

From the last volume install the CodeMeter application by execut-
ing its *.mpkg file.

The installation routine of the CodeMeter application is started which 
will guide you through the installation.

Follow the instructions given on the screen.

The CodeMeter application is then installed on your computer. The in-
stallation is finished as soon as a message reports this.

You can leave out the CodeMeter installation when you intend 
to run Spycer as Spycer Basic only. However, when using float-
ing licenses (see section “Floating License” on page 2-14), all 
involved systems must have the CodeMeter application in-
stalled.
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Afterwards plug the dongle into a free USB port at the computer 
system (see also section “License Issues” on page 2-11).

The dongle providing the license is registered automatically by the 
CodeMeter application (this may take some time) and you will see the 
dongle as an additional drive on your desktop. After this continue the 
installation with the installation of the Spycer application.

Spycer Installation

To install Spycer perform the following:

If not already the case, open the installation file of Spycer which will 
mount it as a volume (Install_Spycer_<version 
no.>_<OS>.dmg, e.g. with a double-click of the mouse).

From this volume install the Spycer application by executing its 
*.mpkg file.

The installation routine of the Spycer application is started which will 
guide you through the installation.

Follow the instructions given on the screen.

This installs all necessary files and libraries of Spycer on the computer 
system.

With this the installation of the software is complete and as a next step 
you have to perform its initial setup to be able to run the program. It 
has to be made when the Spycer application is started for the first time 
and can be called with a normal user account (see section “Starting the 
Software” on page 3-7 and section “Initial Setup of Spycer” on 
page 3-9).

3.1.3 Installation under Windows

The installation routine of a stand-alone Spycer for the Windows oper-
ating system is a single executable file. Usually, it can be found on the 
enclosed CD-ROM. To begin the installation perform the following:

If you are in possession of a licensed version of Spycer fasten the 
Spycer key chain to the dongle (both are included in the delivery of 
a licensed version). With this you will be able to identify the dongle 
belonging to Spycer easily in the future.

Next, if available, plug the dongle into a free USB port at the com-
puter system where Spycer should be installed (see also section 
“License Issues” on page 2-11).

Afterwards open a file manager (e.g. Windows Explorer) on the 
computer system and browse the CD-ROM.
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Execute the installation file of Spycer, for example, with a double-
click of the mouse.

This starts the installation routine which will guide you through the in-
stallation.

Follow the instructions given on the screen.

During the installation procedure all necessary files and libraries will be 
installed on the computer system. The installation is finished as soon as 
a message reports this.

With this the installation of the software is complete and as a next step 
you have to perform its initial setup to be able to run the program. It 
has to be made when the Spycer application is started for the first time 
(see section “Starting the Software” on page 3-7 and section “Initial 
Setup of Spycer” on page 3-9).

The installation file also comprises the CodeMeter installation 
(application to recognize and administer the dongle). In case 
you want to use Spycer as Spycer Basic only, an installation of 
the CodeMeter application is not necessary. You can deselect 
its installation in one of the installation routine’s windows.

However, when using floating licenses (see section “Floating 
License” on page 2-14), all involved systems must have the 
CodeMeter application installed.

To run Spycer successfully under the Windows Vista operating 
system please see section “Troubleshooting under Windows 
Vista” on page A-4.
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3.2 Starting the Software

This section provides you with a description how to get Spycer started. 
Because the software can be run under several operating systems, it is 
divided into the different starting procedures for each supported oper-
ating system.

3.2.1 Starting the Software under Linux

To get the software started under the Linux operating system perform 
the following:

Select from the system menu of Linux the entry Audio & Video » 
Spycer.
Alternatively, you may also start the program from a command line 
(shell) by entering Spycer.

This will load the Spycer application by DVS (see section “Overview of 
the User Interface” on page 3-16).

3.2.2 Starting the Software under Mac OS

To get the software started under a Mac operating system perform the 
following:

Select from the Applications folder of Mac OS the entry 
Spycer.app.

This will load the Spycer application by DVS (see section “Overview of 
the User Interface” on page 3-16).

On several DVS video systems (e.g. CLIPSTER or the 
Pronto2K.2) Spycer is by default integrated in the DVS soft-
ware and thus not needed as a stand-alone application. To start 
the software there you have to start the respective DVS soft-
ware (see section “Starting the Integrated Spycer” on 
page 3-18).

The very first starting of the software will launch its initial setup 
necessary to run the software (see section “Initial Setup of 
Spycer” on page 3-9).

When Spycer is started, a log file is written to a directory that 
logs the actions performed with the Spycer user interface (see 
section “Gathering Diagnostic Information” on page 8-28 and 
section “Interesting Files and Folders” on page A-10 for fur-
ther information).
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3.2.3 Starting the Software under Windows

To get the software started under the Windows operating system per-
form the following:

Select from the START button menu of Windows on the submenu 
DVS the entry for Spycer (for example, All Programs » DVS » 
DVS Spycer).
Alternatively, you may also start the program via the Spycer icon on 
the desktop of Windows.

This will load the Spycer application by DVS (see section “Overview of 
the User Interface” on page 3-16).

In case the option Mount network drives was selected the 
last time the program was exited, you will be asked by a mes-
sage window to type in your password to legitimize your access 
to mounted network drives (see section “The Group ’Network 
Drives’ (Windows Only)” on page 8-11).
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3.3 Initial Setup of Spycer

When Spycer is started for the first time (see section “Starting the Soft-
ware” on page 3-7), it will automatically initiate a setup procedure and 
guide you through some configuration settings. These have to be spec-
ified in order to run Spycer.

In detail the setup procedure consists of the following configuration 
steps:

1. General settings 
2. Watch folder settings 
3. Sequence file types settings 
4. Remote access permissions 
5. Finishing the setup 

Once the respective settings for the displayed configuration step are 
concluded, you can proceed to the following configuration step with 
the NEXT button until the setup is finished and the software is started. 
The button BACK takes you to the previous configuration step while the 
button CANCEL aborts the setup procedure without starting the pro-
gram. The required settings possibilities will be explained in this section.

3.3.1 General Settings

The first configuration settings to make are some general settings. With 
them you determine the network connection of Spycer and whether a 
local content management should be enabled or disabled:

The settings of the initial setup procedure are identical to some 
of the general configuration settings of Spycer. For further de-
scriptions about individual settings items not explained in the 
following please refer to section “Configuring Spycer” on 
page 8-4.

For further information about the SpycerNet and the back-
ground process SpycerAgent see section “Software Structure” 
on page 2-5.
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Figure 3-1: General settings

From the available combo box choose the IP address that Spycer should 
use to communicate with other Spycer applications in a network, there-
by forming the SpycerNet.

The IP addresses that can be selected with the combo box are detected 
by Spycer automatically. They are read from the currently active net-
work connections of your system. If there is more than one network 
connection available, you can select between them via their IP address-
es. In case a network connection is inactive (e.g. no cable connected), 
its IP address will not appear in the drop-down list. Then establish a net-
work connection at the respective connector and click the REFRESH 
button. This will make its IP address available in Spycer.

Additionally available is the localhost address (127.0.0.1) to disable the 
network connection for Spycer and run it locally only.

Under Windows you can gather the IP address of a network 
port via the network connection icon in the system tray of the 
Windows task bar.

Some network ports have to be free and available to connect 
successfully to the SpycerNet. Otherwise Spycer will be con-
fined to its localhost only (IP address 127.0.0.1 has to be used). 
For further information about this please see section “Impor-
tant Notes” on page 1-8.
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With the entry field you can select a name for the home system (host). 
It will be used as the system’s name when appearing in the SpycerNet. 
You can assign any name you want (special characters as well). To take 
your entry into effect you have to press the button SET HOSTNAME.

The two radio buttons at the bottom of the settings area determine 
whether a local content management should be performed. Without a 
local content management enabled Spycer will not display any local 
drives or storages nor observe any locally stored content. Then the user 
interface can be used as a network browser only, i.e. it will display data 
provided by other Spycer applications via the SpycerNet only. If the lo-
cal content management is enabled, the process SpycerAgent will be 
running in the background of your system showing you the local drives 
and storages as well as administering the database making the locally 
stored material available to Spycer and the SpycerNet.

3.3.2 Watch Folder Settings

If a local content management has been enabled, you have to set the 
watch folders next. This step will be skipped in case the local content 
management has been disabled (SpycerAgent disabled, see section 
“General Settings” on page 3-9).

With the watch folders you determine the locations on your local stor-
age that should be searched for video and audio material by the Spycer-
Agent and afterwards be monitored for file movements. All data found 
in these volumes/directories will be written into a database adminis-
tered by the SpycerAgent. The contents of the database is then dis-
played in Spycer and available for search procedures. Additionally, it is 
the database that will be visible to other Spycers in the SpycerNet if 
browse and search permissions are given (see section “Remote Access 
Permissions” on page 3-14).

You have to select one of the radio buttons. As long as no se-
lection is made, the button NEXT will be unavailable.

If the IP address is set to ’localhost’ and the local content man-
agement is disabled, Spycer will display no data at all.

A viewing or reading of contents on other drives or directories 
on your system (local reading including that of mounted net-
work drives) is still possible with Spycer. With a local content 
management enabled, the application displays all data locally 
available when selected in its browser. However, because the 
contents of these locations are not scanned and indexed in the 
database, they are read when accessed only and neither will a 
search with Spycer include these locations nor will they be vis-
ible in the SpycerNet.
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Figure 3-2: Watch folders settings

To determine that a folder (either a drive or directory) should be 
watched by the background process, add it to the list box with the but-
ton INCLUDE FOLDER…. Normally this will be the local drive or directory 
where the video data is stored. Of course, you can add more than just 
one folder to this list in case your data is distributed over several drives/
directories. For example, CLIPSTER or the Pronto2K.2 by DVS usually 
use the local drive V:/ to store video and audio data. So the drive V:/ 
should be added to the list box above via the INCLUDE FOLDER… but-
ton.

With the button EXCLUDE FOLDER… you can specify drives and direc-
tories that should not appear in the SpycerNet or the Spycer user inter-
face. Usually with this you exclude them from being scanned into the 
database (as a subdirectory of an included folder). For example, CLIP-
STER or the Pronto2K.2 also store video related system data on the vid-
eo drive to make this information available in real time (e.g. proxies or 
prerendered images). Normally they would be displayed in Spycer as 
well. To exclude them from an appearance during browsing or search-
ing add their location to the list box above via the button EXCLUDE 

Network drives and important system drives/directories cannot 
be selected as watch folders.

The SpycerAgent registers all data (even unknown files) as well 
as all events that take place in the watch folders. To minimize 
the size of its database and the overall traffic for the Spycer-
Agent it is recommended to include directories/drives that con-
tain files of formats supported by Spycer only (see section 
“Supported File Formats” on page A-5).
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FOLDER…. Nevertheless, other drives/directories can be excluded as 
well whereupon they will not be displayed in Spycer at all.

3.3.3 Sequence File Types Settings

With a local content management enabled, you also have to determine 
the file types that Spycer should not display as sequence file types. This 
step will be skipped in case the local content management has been dis-
abled (see section “General Settings” on page 3-9).

Video material is often stored not in a single file, but in numerous indi-
vidual image files gathered in one directory, where one file on the stor-
age equals one frame of video. These image sequences will be 
displayed by Spycer as a single entry, i.e. as one video clip. By default 
the Spycer application treats all file formats as sequence files. Thus, 
when files are stored in one directory with identical names (e.g. prefix-
es) and a numbering (frame number), they will be shown as a video se-
quence, i.e. by a single entry. To avoid this you can determine with the 
sequence file types settings the file formats that Spycer should display 
file by file even if their file names are identical and contain a numbering.

Figure 3-3: Sequence file types settings

The most common file formats that should be displayed file by file are 
already predefined.

Add additional file formats to the list with the help of the button ADD, 
or revise the list by either altering entries (double-click with the mouse) 
or selecting an entry and deleting it from the list with the button RE-
MOVE.
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3.3.4 Remote Access Permissions

If a local content management has been enabled, you have to set the 
remote access permissions next. This step will be skipped in case the lo-
cal content management has been disabled (see section “General Set-
tings” on page 3-9).

With the remote access permissions you determine what other Spycer 
applications in the network (SpycerNet) are allowed to do on your sys-
tem.

Figure 3-4: Permissions settings

In the right pane titled Remote Access Permissions select the per-
missions according to the following:

Other Spycer applications have access to the material in your 
watched folders only (see section “Watch Folder Settings” on 
page 3-11 and section “SpycerAgent” on page 2-6).

To allow other Spycer applications to defragment data on your 
system both read and write permissions have to be given.

Browse & Search Other Spycer applications can browse your data 
and perform searches. If a proxy clip of a video 
clip is available on your system, other Spycer ap-
plications can download it for a preview.

Edit Metadata If this check box is enabled, other Spycer appli-
cations can edit the metadata of your material 
on your system, including the header data of 
*.dpx image sequences.
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3.3.5 Finishing the Setup

When the last configuration is made, the following screen will be dis-
played:

Figure 3-5: Setup completed

Then you can finish the setup procedure by pressing the button OK 
which will start the Spycer application (see section “Overview of the 
User Interface” on page 3-16).

Read Essence This setting allows the reading of data on your 
system, for example, for copying processes. To 
allow for a remote defragmentation or proxy 
clip generation this check box has to be activat-
ed as well.

Write Essence This setting allows the writing of data on your 
system, for example, for copying processes. To 
allow for a remote defragmentation or proxy 
clip generation this check box has to be activat-
ed as well.

If Spycer is started for the first time with no database available, 
the initial scanning of the watched folders may take some time 
depending on the amount of data stored in these locations. As 
long as the scanning process is active, your system will have the 
status ’busy’ (see section “The Status Bar” on page 4-9).
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3.4 Overview of the User Interface

The following figure shows the user interface of Spycer as it appears af-
ter starting the program (see section “Starting the Software” on 
page 3-7):

Figure 3-6: User interface of Spycer

The user interface provides the following items:

menu bar At the top of the Spycer user interface you can find 
a menu bar. It provides access to functions and tasks 
of an administrative nature to Spycer. Here you can 
find, for example, its configuration settings as well 
as several tools. A short reference to the menu bar 
can be found in section “Menu Bar Reference” on 
page 8-18.

menu bar metadata area preview area

browse and search area
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On Mac systems the menu bar is not avail-
able as it is under other operating systems. 
Instead its options can be found in the 
standard program menu bar of the operat-
ing system (see section “The Menu Bar on 
Mac OS” on page 8-18).

metadata area Directly below the menu bar you can find the meta-
data area which will show you the properties and 
metadata of the file currently singled out in the 
browse and search area. You can switch through as 
well as add and edit the metadata easily with the 
buttons provided to the left. For more details about 
the metadata area and its various functions see 
chapter “Working with Metadata” on page 6-1.

preview area To the right of the metadata area you can find the 
preview area. In Spycer this area is used to view or 
listen to the currently singled out data. At the top 
you can find a video overlay where you can see the 
content of the material (e.g. of video clips). Below 
the video overlay a scrub bar of the material’s time-
line is available as well as the preview controls. The 
preview area is described in chapter “Previewing 
Data” on page 5-1.

browse and 
search area

With the browse and search area you can browse lo-
cal or network storages in up to two browsing 
panes. This area also provides the search tool of 
Spycer which enables you to find material easily by 
combining various parameters, such as file names or 
metadata information. This area and its functionality 
is explained in chapter “Browsing and Searching” on 
page 4-1.

The view of the metadata and preview area can be switched 
with the job list or scheduler of Spycer. You can find further in-
formation about them in chapter “Managing Data” on 
page 7-1.
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3.5 The Integrated Spycer

On several DVS video systems, such as CLIPSTER or the Pronto2K.2, 
Spycer is integrated in the DVS software which makes it unnecessary to 
install Spycer as a stand-alone application. With the integrated Spycer 
you can seamlessly work together with the other software modules of 
the DVS software.

3.5.1 Starting the Integrated Spycer

To start Spycer integrated in the DVS software you have to start the 
DVS software. Then it can be loaded the same way as most other mod-
ules of the DVS software:

Start the DVS software of the DVS video device. For details about 
how to do this please refer to the documentation of the video sys-
tem software.

Next press the button SPYCER in the task bar of the DVS software 
(see figure 3-7 on page 3-19).

This will load Spycer as a software module of the DVS software:

When the software module of Spycer is started for the first 
time, the initial setup of the application may be launched. Then 
you have to detail the necessary configurations as described in 
section “Initial Setup of Spycer” on page 3-9. If not, it is rec-
ommended to check whether the configurations match your 
needs (see section “Configuring Spycer” on page 8-4).

In case the option Mount network drives was selected the 
last time the program was exited, you will be asked by a mes-
sage window to type in your password to legitimize your access 
to mounted network drives (see section “The Group ’Network 
Drives’ (Windows Only)” on page 8-11).
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Figure 3-7: The integrated Spycer

3.5.2 Using the Integrated Spycer

The integrated Spycer can be used the same way as described in this 
user guide. In addition it provides the following functionality:

With the integrated Spycer you will notice right below the menu bar of 
the DVS software the bin as it is available in the Edit or I/O Tool. Once 
audio and video clips are displayed in the browse and search area that 
are locally available or stored on a SAN, they can be dragged and 
dropped to the contents area of the bin:

For an overview of the Spycer software module please see sec-
tion “Overview of the User Interface” on page 3-16.

bin

task bar
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Figure 3-8: Drag and drop of clip to bin

This will add the selected clip to the contents area of the bin.

Below the user interface of the Spycer software module the task bar of 
the DVS software will be available as usual. With it you can switch to 
the other modules of the software, such as the Edit or the I/O Tool. Af-
ter a switching to the Edit or I/O Tool of the DVS software the clip(s) 
added to the bin will still be available and can be used as usual.

3.5.3 Configuring the Integrated Spycer

The general configuration settings available for the stand-alone appli-
cation of Spycer (see section “Configuring Spycer” on page 8-4) can be 
set for the integrated Spycer as well. For this you have to start the Con-
figuration Tool of the DVS software.

Further information about the bin and the task bar can be 
found in the documentation of the Edit Tool of the respective 
DVS video system.
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Figure 3-9: The Configuration Tool with Spycer settings

Under the default settings for the DVS software (tab Default) you can 
find in the group list several entries regarding Spycer. They provide the 
same settings as described in section “Configuring Spycer” on 
page 8-4.

3.5.4 Exiting the Integrated Spycer

The Spycer application integrated in the video system’s software will be 
ended when the whole DVS software is exited. Further information 
about how to do this can be found in the documentation of the video 
system software.

Further information about the Configuration Tool of the DVS 
software can be found in the documentation of your DVS vid-
eo system.

Exiting the DVS software and thus the integrated Spycer will 
not terminate the background process when a local content 
management is enabled. The process is started during the load-
ing of the operating system (fully operational even with no user 
logged in) and terminated only when the system is shut down 
(see section “SpycerAgent” on page 2-6 for more details).
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3.6 Changing the Layout of the User Interface

The layout of the user interface of Spycer can be changed to your per-
sonal requirements. You can maximize the view of the user interface or 
of the preview area as well as change the size of areas. All alterations 
will be saved when the software is closed.

This section describes how to change the size of areas of Spycer.

Generally, the software user interface shows a separation line vertically 
or horizontally wherever the layout of areas can be changed.

Figure 3-10: Separation line between areas

This line can be taken with the mouse and moved to another position. 
For example, to alter the size of the two browsing panes perform the 
following:

Move the separation line between the two browsing panes to the 
left or to the right:

Figure 3-11: Example how to adjust the layout of the software

The horizontal size of the two browsing panes will adjust accordingly.

Furthermore, if you pull a separation line completely to the left/right or 
up/down, the respective area will no longer be visible and thus can be 
turned off (hidden). This way you can, for instance, make information 
visible that you may otherwise have to scroll to.

Information about how to maximize certain areas or the user 
interface itself can be found in section “The Video Overlay” on 
page 5-6 and section “The ’Spycer’/Spycer Icon Menu” on 
page 8-19.

The layout of the user interface can be set back to a default lay-
out by using the menu option Reset Layout on the menu 
View (see section “The ’View’ Menu” on page 8-21).

separation line
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3.7 Exiting the Software

To end the current Spycer session perform the following:

Select the option Quit on the Spycer menu (Mac: Spycer » Quit 
Spycer) or press the key combination [Alt + F4] (Mac: [ + Q]) 
alternatively.

The user interface of Spycer will be closed and you can then, for in-
stance, shut down the computer system.

The Spycer application integrated in the DVS software on a 
video system by DVS (such as CLIPSTER or the Pronto2K.2) will 
be ended when the whole DVS software is exited. Further in-
formation about how to do this can be found in the documen-
tation of the video system software, while for more 
information about the integrated Spycer consult section “The 
Integrated Spycer” on page 3-18.

Exiting Spycer will not terminate the background process when 
a local content management is enabled. The process is started 
during the loading of the operating system (fully operational 
even with no user logged in) and terminated only when the 
system is shut down (see section “SpycerAgent” on page 2-6 
for more details).

Linux/Windows only: In fullscreen mode the menu Spycer 
will be replaced by the Spycer icon. However, it provides the 
same menu options as the menu Spycer (see section “The 
’Spycer’/Spycer Icon Menu” on page 8-19).

When exiting Spycer, the log file opened during the starting of 
the application is finished and saved (see section “Starting the 
Software” on page 3-7).



3-24

Spycer User Guide



4-1

2

1

3

4

6

5

7

4

I

A

8

Browsing and Searching

In the lower part of the Spycer user interface you can find the browse 
and search area. With it you can browse local or network storages in up 
to two browsing panes.

This area also provides Spycer’s search tool enabling you to find any 
searched for material easily by combining various search parameters, 
such as file names or metadata information.

This chapter first explains the browse tool, followed by a description 
how to initiate and perform a search with Spycer.
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4.1 Browsing for Data

With the button BROWSE at the top left side of the 
browse and search area you can activate the browse 

tool of Spycer if not already visible in the user interface.

Figure 4-1: The browse tool

It offers two browsing panes for overview purposes and drag-and-drop 
procedures. The following figure gives an overview of one of the 
browsing panes:

Figure 4-2: Overview of a browsing pane

This section explains the browse tool in detail. First the individual items 
of a browsing pane as indicated in the figure above will be described, 
complemented by an explanation of the context menu available in the 
browse and search area. The section will be concluded with some sam-
ple step-by-step descriptions how to use the browse tool of Spycer.

directory
tree

directory
controls

contents
area

status
bar
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4.1.1 The Directory Tree

The directory tree enables you to see the contents of your system/net-
work in a folder structure.

Figure 4-3: Overview of the directory tree

With the network/system combo box at the top of the directory tree 
you can select whether you want to view the contents of a particular 
system or the whole network:

Figure 4-4: Network/system combo box

Once a selection is made in the combo box, you can browse the net-
work or system in the folder structure. Either by double-clicking an en-
try with the mouse or by clicking on the plus (+) or minus (-) sign in 
front of an icon you can expand or collapse the contents sorted under 
this item.

network/system
combo box

folder structure
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The different icons provided by the directory tree indicate the follow-
ing:

Furthermore, there are several drive and directory icons available:

The whole network. The whole network, i.e. all systems 
in the SpycerNet as well as the home system, is displayed 
and can be used for the respective task.

A foreign system. This icon indicates a foreign system in 
the SpycerNet. When selected, only this particular sys-
tem (i.e. its watched folders) will be visible and used for 
the respective task.

Same as ’a foreign system’ but with an older Spycer ver-
sion running. Some features that you can perform on 
your system cannot be triggered on the foreign system. 
See section “Notes about Networking with Spycer” on 
page 2-9 for further information.

The home system. This icon stands for the host system. 
When selected, all its local storages will be visible and 
used for the respective task (for a search only the 
watched folders).

When an icon is displayed together with a clock ( ), its sys-
tem is busy (see section “The Status Bar” on page 4-9).

A drive of an SNFS volume (SAN).

A normal system drive (e.g. an NTFS volume).

A directory/subdirectory of a drive that does not contain 
data directly. However, it may contain subfolders that 
carry data.

A directory/subdirectory of a drive containing data that 
will be displayed in the contents area of the browsing 
pane as soon as the folder is selected.

Other drives, such as USB storages or network drives will also 
be indicated by different icons.
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The states of the drives and folders are shown in the folder structure of 
the directory tree via colors:

As soon as a drive/directory is selected that contains data, its contents 
will be displayed in the contents area of the browsing pane.

4.1.2 The Directory Controls

With the directory controls at the top of each browsing pane you can 
control the directory tree. It offers the following possibilities:

Directory Color Explanation

light blue This drive/directory is locally available but neither 
explicitly included nor excluded in the watch fold-
er settings. However, it may contain a subdirecto-
ry that is a watched folder. File-based processes in 
these drives/directories are possible (e.g. copy, 
move or delete procedures).

The contents of these locations are not in-
cluded in the database of Spycer and they 
are read when accessed only. Thus it may 
take some time to open them, especially 
when they contain a lot of data.

With the menu option View on the con-
text menu of the directory tree, it is also 
possible to hide these locations. Then 
only the watched folders will be visible in 
the directory tree (see section “The Con-
text Menu” on page 4-9).

dark blue This drive/directory is monitored by the back-
ground process, i.e. it is a watched folder.

For further information about watched folders see section 
“Watch Folder Settings” on page 3-11.

This button moves you one item up in the folder struc-
ture.

This button adds a new subdirectory to the currently se-
lected drive/directory. It opens a dialog window where 
you have to enter the name of the new directory. After 
confirming the name with the button OK the directory 
will be created.
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4.1.3 The Contents Area

The contents area of a browsing pane shows you the contents of the 
currently selected drive/directory in the directory tree. All files at the se-
lected storage location will be displayed, either in text information or 
thumbnail view depending on the viewing settings for the respective 
browsing pane (see section “The Status Bar” on page 4-9).

In the text information view you will receive a detailed list of the folder’s 
content. In this view you can easily sort the files/clips in ascending or 
descending order by clicking on the column heading that the data 
should be sorted by.

Figure 4-5: Contents area in text view

When in the thumbnail view, still images and video clips are shown in 
the contents area of a browsing pane with a thumbnail preview. In this 
view you will get additional information about the displayed material 
via text that appears to the right of the thumbnail.

The field Path details the path to the currently selected 
directory: First the drive letter is given, followed by the 
directory path.

A contents area providing the same features as explained here 
as well as in section “The Status Bar” on page 4-9 and section 
“The Context Menu” on page 4-9 is also available in the 
search tool after performing a search (see section “The Results 
Area” on page 4-19).

With the menu option View on the context menu of the con-
tents area, you can also display directories that are available at 
the selected location (see section “The Context Menu” on 
page 4-9).
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Figure 4-6: Contents area in thumbnail view

The following table shows the material and data types that can be 
viewed in the contents area of a browsing area and explains the way 
they are displayed:

video clips: In the thumbnail view video clips are 
shown in the contents area of a brows-
ing pane with a thumbnail preview. 
When a clip is selected, a scrub bar be-
low the thumbnail will be available that 
can be used to preview the clip in still 
images (see section “Previewing Data 
via Thumbnails” on page 5-2).

In the text information view video clips 
are indicated by this icon. In case it is 
visible in the thumbnail view, it indi-
cates either a video clip whose data is 
currently not available or an invalid clip. 
Then wait a few seconds and give 
Spycer time to gather the data. If nec-
essary, refresh the view of the directo-
ry/contents area. If after that the icon is 
still visible, see to it that the right video 
material is provided on the respective 
video storage.

audio clips: Audio clips are shown with this icon in 
the browsing pane (in the text informa-
tion as well as thumbnail view). Audio 
files that contain more than one mono 
or stereo channel (multiple channels) 
are also supported by Spycer.
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project files: Project files of a video system software 
by DVS (e.g. the CLIPSTER or the 
Pronto2K.2 software) will be shown 
with this icon in the browsing pane 
(text information as well as thumbnail 
view).

still images: Still images, i.e. single image files of a 
file format that Spycer supports, are 
also displayed in Spycer. In the thumb-
nail view still images are shown with a 
thumbnail preview. However, because 
they are not video clips they do not 
provide a scrub bar when selected.

In the text information view still images 
are indicated by this icon. In case it is 
visible in the thumbnail view, it indi-
cates either a still image whose data is 
currently not available or an invalid im-
age. Then wait a few seconds and give 
Spycer time to gather the data. If nec-
essary, refresh the view of the directo-
ry/contents area. If after that the icon is 
still visible, see to it that the right data 
is provided on the respective storage.

unknown: Spycer shows all files available on the 
storage, even files of unknown for-
mats. Files that are not recognized by 
Spycer are displayed with this icon (text 
information as well as thumbnail view). 
However, because each will be worth 
one entry in the database of the 
SpycerAgent, your storage should con-
tain as few of these files as possible. 
Otherwise search procedures may get 
lengthy due to unnecessary overhead.

directories/
drives/
systems:

Other items may be displayed in the contents area with 
appropriate thumbnails/icons as well, such as directories 
(if enabled, see menu option View in section “The Con-
text Menu” on page 4-9), drives or systems. For further 
information about them see section “The Directory 
Tree” on page 4-3.
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4.1.4 The Status Bar

The status bar at the bottom of a browsing pane offers you several con-
figuration settings for its contents area as well as a status indication of 
the currently selected system. In detail it provides the following:

4.1.5 The Context Menu

The context menu of the browsing pane (usually invoked with a right-
click of the mouse) provides different directory and file related func-
tions, such as the deletion of a directory and/or file.

Further information about the text information and thumbnail 
view can be found in section “The Contents Area” on 
page 4-6.

Use the button TEXT to view the files/clips in the con-
tents area with their text information only.

With the button IMAGE you can activate the view of the 
thumbnails.

This combo box enables you to a selective viewing of the 
material displayed in the contents area. Select from it the 
type of data that should be visible in the contents area 
only.

This field indicates the status of the system currently se-
lected in the directory tree (see section “The Directory 
Tree” on page 4-3). When it shows Online, it is ready 
for further processing tasks. When it shows Busy writ-
ten in red, the system is occupied by a task and will react 
to your command as soon as it is ready again. The status 
Busy may be displayed, for example, when the system 
is performing a real-time operation or in case the data-
base of its Spycer application is updated. In the browsing 
panes the icons of systems that are busy will be dis-
played together with a clock (see section “The Directory 
Tree” on page 4-3).
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Figure 4-7: Context menu of a directory

The context menu provides the following functions:

Depending on whether the context menu is invoked in a direc-
tory tree or in a contents area it may provide different menu 
options. The following list details all options that are available.

Open with Available for the contents area and files on the 
home system only. This menu option provides a 
submenu where you can select between several 
possible applications to open the currently select-
ed file with. You can, for example, open the file in 
the standard file manager of your operating sys-
tem (Mac and Windows only) or in the application 
that is configured as the default application for this 
file format (menu option Default).

Show all content Available for the directory tree only. Initiates a 
search for all data available at the selected location 
and displays it in the results area (subdirectories 
are searched as well, see section “The Results Ar-
ea” on page 4-19).

Actually this option performs a search for 
the respective directory (search string) in 
the criteria File Path. As a result you 
receive all entries in the database that 
contain the searched for string in their file 
paths.
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Show all 
metadata 

Available for the contents area only. Performs the 
same operation as a double click on a file in the 
contents area: The file is singled out and is dis-
played in the metadata and preview area.

Show in browser Available for the results area after a search only. 
Shows the selected file in the browse area of Spyc-
er thereby displaying its location.

Save as TXT… Available for the contents area only. Saves the text 
information of the files currently selected in the 
contents area to an ASCII file.

Select all Available for the contents area only. Selects all files 
available in the contents area.

Move to folder… Moves the selected directory/file(s) to another lo-
cation. When activated it will open a dialog win-
dow where you can select a new storage location 
on your home system.

A direct moving of directories/files in the 
SpycerNet is not possible. Within the net-
work directories/files can be copied only.

Copy Copies the selected directory/file(s) to the clip-
board of the operating system.

Paste Pastes the contents of the clipboard (see Copy) at 
the currently selected location.

Delete After the confirmation of a warning message this 
menu option deletes the selected directory/file 
from the storage.

This menu option deletes the selected di-
rectory/file physically from the storage. It 
is directly deleted and there is no undo 
functionality or recycle bin available to 
restore the data.

New folder… Creates a new subdirectory at the currently select-
ed location. This menu option opens a dialog win-
dow where you have to enter the name of the 
new directory. After confirming the name with the 
button OK the directory will be created.
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Rename… Changes the name of an already existing directo-
ry/file. It opens a dialog window where you have 
to enter the new name. After confirming the 
changes with the button OK the directory/file will 
be named accordingly.

When called for a video clip whose 
frames consist of still images, it will open 
the renaming tool for clips (see section 
“Renaming” on page 7-2).

Re-scan Available for the directory tree only. Sometimes 
the SpycerAgent may not detect an event. Then 
you can use this menu option to rescan the cur-
rently selected drive/directory and revise its entries 
in the database. Any virtually added metadata 
such as the production metadata will be retained.

Refresh This menu option refreshes and updates the view 
of the currently selected drive/directory.

Defragment Initiates a defragmentation of the currently select-
ed file, directory or drive. Further information 
about this can be found in section “Defragment-
er” on page 7-4.

Create proxy Available for the contents area and video clips 
only. Creates a proxy of the currently selected vid-
eo clip. Then the proxy clip is created on the sys-
tem where the clip resides. Afterwards you can use 
it to view the video clip in real time.

To create a proxy you must have read and 
write permissions on the respective sys-
tem and the native Spycer application 
must be appropriately configured for the 
creation of proxies.

Further information about proxies and 
the previewing of proxies can be found in 
section “Previewing Data with the Pre-
view Area” on page 5-4.

Convert… Available for the contents area and video/image 
files only. Opens the file format conversion tool of 
Spycer to convert the selected video clip or still im-
age to another file format. Further information 
about this can be found in section “File Format 
Converter” on page 7-8.
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4.1.6 Using the Browse Tool

With the browse tool you can browse local or network storages in up 
to two browsing panes. Additionally, you can perform all directory and 
file related tasks here, for example, create new or delete existing as well 
as copy, move or rename directories or files.

The following describes step-by-step some sample tasks illustrating 
how to use the browse tool, i.e. it will be explained how to copy and 
move directories/files as well as how to delete them.

Copying (Moving) Directories/Files

Copying directories/files with the browse tool of Spycer can be per-
formed without effort. It offers two browsing panes where you can do 
this easily via drag-and-drop. When operating between storage loca-
tions at your home system, directories and files can also be moved:

If not already visible in the user interface activate 
the browse tool with the button BROWSE at the 
top left side of the browse and search area.

Then the user interface displays the two browsing panes of Spycer.

View The menu option View enables you to configure 
which items to see in the directory tree and/or the 
contents area.

When invoked on the directory tree, it shows the 
menu option Hide unwatched folders. With it 
you can hide all drives/directories, that are not 
watched by the SpycerAgent. Once the menu op-
tion is activated, it shows a cross in front and only 
the watched folders will be displayed in the direc-
tory tree.

When invoked in the contents area, it shows 
Show folders. This menu option allows you to 
view directories in the contents area. Once acti-
vated, it shows a cross in front and directories 
available at the selected location will be displayed 
in the contents area as well.

Properties… With this menu option you can call up the proper-
ties of the file, directory or drive where the context 
menu was invoked. They will be shown in the 
properties window. Further information about this 
can be found in section “The Properties Window” 
on page 8-2.
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Figure 4-8: The browse tool

In the directory tree of the left pane browse to your target directory, 
i.e. the directory where the data should be copied to.

In the right browsing pane browse to the directory containing the 
material that should be copied, i.e. the source directory.

After that select in the right browsing pane the material (either a 
drive/directory from the directory tree or files from the contents 
area) that should be copied or moved.

Now drag and drop the selected material to the left browsing pane 
by using the left mouse button. It can be dropped either in its con-
tents area as shown in the following figure or on the target direc-
tory in the directory tree.

Figure 4-9: The browse tool

Files in the contents area can be selected as easily as in a file 
manager. For example, you can select a range of adjoining 
files with the mouse when the [Shift] key is pressed, while 
disjointedly you can select them when the [Ctrl] key 
(Mac: [ ]) is pressed. Further information about this can be 
found in section “Keyboard Shortcuts” on page A-9.
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This will copy the material to the target location.

Deleting Files/Directories

Files or directories can be deleted just as easily as they can be copied:

Select a file or directory in one of the browsing panes.

After this press the key [Del] on your keyboard.

A warning message will appear where you have to confirm that you re-
ally want to delete the file/directory.

In the warning message press the button YES to confirm the dele-
tion.

This will delete the selected file or directory. If a directory is deleted, the 
subdirectories and all material sorted under this directory will be deleted 
as well.

Between different systems in the network data can be copied 
only to prevent an unintentional removing of material from the 
native system.

Within the home system the material can also be moved. To 
change from a copying to a moving, press the [Alt] key during 
the drag-and-drop procedure.

If the drag-and-drop procedure is performed with the right 
mouse button instead of the left one, you will receive a context 
menu at the target location allowing you to select whether the 
data should be copied or moved.

A copying or moving can also be performed via the menu op-
tions available on the context menu of files and directories 
(Copy, Paste or Move to folder…, see section “The Context 
Menu” on page 4-9).

The file/directory will be directly deleted from the storage. 
There is no undo functionality or recycle bin available to re-
store the data.

To delete files or directories you may also use the menu option 
Delete on the context menu of the respective item (see section 
“The Context Menu” on page 4-9).
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4.2 Searching for Data

With Spycer you can as easily search for data as you can browse for it. 
You will be able to find any searched for material by combining various 
search parameters, such as file names or metadata information.

With a click on the button FIND at the top left side of 
the browse and search area you can activate the 

search tool of Spycer if not already available in the user interface.

Figure 4-10: The search tool

It provides the following areas:

This section explains the search tool of Spycer in detail. First the search 
parameter area will be described, followed by a description of the re-
sults area. The section will be concluded with a step-by-step description 
how to use the search tool of Spycer.

4.2.1 The Search Parameter Area

In the search parameter area you can determine the location where the 
search should be conducted as well as define the search parameters. 
Here you can also save defined search parameters to a file as well as 
load previously saved ones.

Alternatively you can use the keyboard combination [Ctrl + F] 
(Mac: [ + F]) to switch to the search tool of Spycer.

search parameter 
area

In the search parameter area you can determine 
the location where the search should be con-
ducted as well as define the search parameters. 
Here you can also save a search query to a file 
(*.sq) as well as load previously saved ones.

results area The results area of the search tool will display 
the results once a search has been conducted. It 
offers almost the same features as the contents 
area of a browsing pane.

search parameter area results area
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Figure 4-11: The search parameter area

All items of the search parameter area will be explained in the follow-
ing:

Search Location

With the combo box Content on you can determine the location 
where the search should be conducted. Select from it whether you 
want to search the contents of a particular system or the whole net-
work. It offers the same possibilities as the system/network combo box 
in a browsing pane (see section “The Directory Tree” on page 4-3 for 
more details).

Search Parameters

Below the combo box for the search location the search parameters 
have to be detailed. With the combo box to the left determine the 
search criteria that should be used for the search. You can choose from 
a variety of different criteria ranging from file name or extension over 
video/audio properties to metadata information such as the production 
date or company.

Depending on the selected criteria the number of the available fields for 
a search parameter may vary. If three are available, use the one in the 
middle to set an operator for the search (e.g. for a file name 
contains ..., is ..., begins with ... and ends 
with ...). With the last field to the right you have to specify the cri-
teria. It may provide an entry field where you have to type in your 

Only the database of the local storage and/or the databases of 
the Spycer applications in the SpycerNet will be used for a 
search. Drives and directories not indexed in the database(s), 
i.e. not included in the watched folders settings, will be disre-
garded (see section “SpycerAgent” on page 2-6).

search location search parameters controls
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search term or a combo box providing you with a list to choose the 
search item from.

The button + ( ) below the search parameters adds another search pa-
rameter that the search will also observe. With it an AND search is pro-
vided (e.g. when searching for a file name that begins with start AND 
the file extension *.wav, you will receive all file names with the prefix 
’start’ and the Wave file extension such as start_01+02.wav). You 
can add as many AND searches as you like and they can be deleted just 
by clicking the - button ( ) right in front of the additional parameter.

Controls

With the controls at the bottom of the search parameter area you can, 
for example, initiate a search, clear the already defined search parame-
ters or build up a library of often used search queries. In detail it pro-
vides the following items:

For names of video clips you have to observe the C notation 
usually with the syntax <string>%0Yd.<ext>:

<string> Preceding string of file name

% Marker that the following is a format string

0 If the output of the format string does not pro-
vide the stated length, fill it with zeros (0)

Y Number of digits, for example, 5 

d Marker that the format string is a decimal num-
ber

<ext> File extension

With the search Hollywood%05d.dpx entered Spycer will 
yield as a result the clip Hollywood in the DPX file format 
that provides a five digit frame number.

The button RESET clears the already defined search pa-
rameters and resets the search parameter area.

The LOAD button allows you to load previously saved 
search parameters from a file. It opens a dialog window 
where you have to select the respective file containing 
the search query (*.sq). After its confirmation the 
saved search parameters will be loaded into the search 
parameter area of Spycer.
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4.2.2 The Results Area

The results area of the search tool displays the results soon after a 
search was initiated.

Figure 4-12: The results area

Once a search is finished, the number of hits will be displayed at the top 
left of the results area. Right below it the found files can be seen.

With the button SAVE you can save the currently set 
search parameters to a file. Thus you can build up a li-
brary of search queries to use them in the future again. 
A click on this button opens a dialog window where you 
have to specify the storage path and file name of the 
search query file to be saved. After the confirmation of 
your settings the file will be saved to the specified loca-
tion (*.sq).

With the button FIND IT! you start a search. It will be per-
formed at the selected location and will yield the results 
according to the set search parameters in the results area 
to the right. As long as the search is processed, the sys-
tem(s) where the search is performed will be busy, i.e. 
their icons will appear with a clock superimposed (see 
section “The Directory Tree” on page 4-3).

With the focus on the search parameter area a 
search can also be initiated by pressing the [En-
ter] key.
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Most of the results area resembles the contents area of a browsing pane 
and provides its possibilities as well. For example, you can adjust the 
viewing with the controls at the bottom of the results area or you can 
invoke the same context menu on the found files. Therefore, for more 
information about this please refer to section “Browsing for Data” on 
page 4-2.

4.2.3 Using the Search Tool

The usage of the search tool of Spycer is quite straight forward. To start 
a search and display its results do as follows:

Figure 4-13: The search parameter area

Select from the combo box Content on the location where the 
search should be made. Choose from it, for example, a particular 
system in the network.

Afterwards select the search criteria that you want to search for 
from the first combo box of the available search parameter. In our 
example here we will select the criteria File Format.

This will slightly change the appearance of the search parameter entry 
fields and instead of three now only two fields are displayed.

With the menu option Show in browser on the context menu 
of a clip in the results area, you can immediately display the se-
lected file in a browsing pane of Spycer. This way you can de-
termine its location easily.
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Select from the second combo box of the search parameter the 
entry, for example, for the *.tif file format.

Next start the search with the button FIND IT!.
The search will be conducted at the specified location(s). As long as the 
search is processed, the system(s) where the search is performed will be 
busy, i.e. their icons will be shown together with a clock. When fin-
ished, the result will be shown in the results area to the right.

You may use the + button below the specified search parame-
ter to add another parameter that the found *.tif files also 
must provide to be displayed as a result (AND search).

With the criteria File Format you can only select formats 
that are supported by Spycer directly (see section “Supported 
File Formats” on page A-5). However, you can search for any 
file format, even ones unknown to Spycer, by entering its ex-
tension in the criteria File Name (e.g. enter .txt).

To limit the displayed findings in the results area further you 
may also use the selective view combo box (see section “The 
Status Bar” on page 4-9).

By selecting entries in the results area and using the menu op-
tion Save as TXT… on their context menu you can save the 
search result to a text file, for example, for later evaluation.

With the menu option Show in browser on the context menu 
of a clip in the results area, you can immediately display the se-
lected file in a browsing pane of Spycer. This way you can de-
termine its location easily.
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Previewing Data

This chapter provides descriptions where and how to preview data in 
the software.

To the right of the user interface you can find the preview area. In Spyc-
er this area is used to view or play the currently singled out material 
(3D LUT and image files as well as audio and video clips). By creating 
and using proxy clips, video material can also be viewed in real time. At 
the top of the preview area you can find a video overlay where you will 
see the contents of the material. Below the video overlay a scrub bar of 
the material’s timeline is available as well as the preview controls.

Additionally, you can preview image and video data via the thumbnails 
provided in the contents areas when browsing or searching.
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5.1 Previewing Data via Thumbnails

When in the thumbnail view, video and image data can be seen with 
thumbnails in the contents areas of the browse and search tools. Each 
thumbnail is on-the-fly created and displayed as soon as a directory is 
selected that holds video or image data.

Figure 5-1: A contents area

Still images (i.e. single image files) in the browse and search area just 
provide their thumbnails. For video clips, however, the complete time-
line can be previewed via the little scrub bar below its thumbnail. To do 
this perform the following:

If not already selected, select the clip that you want to preview with 
a click of the mouse.

This will make the scrub bar of the thumbnail available.

Move the cursor of the scrub bar to the left or right to view the 
contents of the clip:

Further details about the contents areas of the browse and 
search tools not explained in the following can be found in sec-
tion “Browsing for Data” on page 4-2.

For this you may also use the keys [Left Arrow]/[Right Ar-
row] when the scrub bar has the focus (e.g. after selecting 
it with the mouse).
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Figure 5-2: Preview of a clip in a contents area

The thumbnail above the scrub bar will show you the contents of the 
clip in still images. This can also be used to select a preliminary position 
for the metadata and preview area: When singling out the clip (see e.g. 
section “Previewing Data with the Preview Area” on page 5-4), the po-
sition of the scrub bar cursor will be retained and available there as well.

thumbnail

scrub bar
with cursor
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5.2 Previewing Data with the Preview Area

At the right-hand side of the user interface you can find the preview ar-
ea. In Spycer this area is used to preview the currently singled out ma-
terial.

Figure 5-3: The preview area

With the preview area you can view the color dispersion of 3D LUT files 
in a color cube or the image data of still images and video clips. By cre-
ating and using proxy clips video material can also be played. Further-
more, audio clips can be played in the preview area as well.

At the top of the preview area you can find a video overlay showing 
you the contents of the singled out material. Additionally, for video and 
audio clips a scrub bar is provided below the video overlay as well as 
the preview controls, both allowing you to move within the clip’s con-
tent. At the very bottom a status bar is available that details further in-
formation about video and their proxy clips.

In case the preview area is not visible it is either hidden (see 
section “Changing the Layout of the User Interface” on 
page 3-22) or the view is switched from the metadata and pre-
view area to the view of the job list or the scheduler. To switch 
back to the metadata and preview areas use the button META-
DATA at the top left side of the user interface (see also chapter 
“Working with Metadata” on page 6-1).

For a preview of audio and 3D LUT files you can use locally 
stored data only. A direct preview of this material from other 
systems in the SpycerNet is not possible.

video overlay

scrub bar
preview controls
status bar
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5.2.1 General Information about Proxies

Proxy clips are downscaled versions of high-resolution video material, 
especially created by Spycer to enable previews of video clips in real 
time on systems, even when they are not equipped with real-time hard-
ware. Usually they are generated in a container file format that allows 
for a compression of images as well as an embedding of audio data (if 
available).

The proxy generation, such as its storage location, file format or reso-
lution, can be configured freely with the general configuration settings 
of Spycer (see section “The Group ’Jobs’” on page 8-9). There you can 
also determine that they should be created automatically as soon as 
clips are added to the storage. In case the automatic generation is de-
activated, proxies can be easily created via the context menu of clips in 
the contents areas of the browse and search tools (menu option Create 
proxy, see section “The Context Menu” on page 4-9).

Just as with the database of the local storage, each Spycer application 
cares for and administers the proxies of the video material that is locally 
available only. During the creation of a proxy an entry with a progress 
bar will appear in the job list (see section “The Job List” on page 7-12) 
and the proxy clip is saved at the configured location. There, the direc-
tory structure of the watch folder where the clip is stored is reproduced 
to provide for an easy identification of the proxy clips.

For a real-time preview of clips locally stored, the proxies will be avail-
able immediately. The proxy’s status is detailed in the status bar of the 
preview area (see section “The Status Bar” on page 5-8) when a clip is 
singled out.

In the SpycerNet proxies are shared among the Spycer applications. 
When a proxy clip is available on a foreign system and the clip is singled 
out for a preview, its proxy will be downloaded from the other system 
and temporarily stored on your system. It will be removed from your 

To create proxies on your system the proxy generation has to 
be enabled and configured first (see section “The Group 
’Jobs’” on page 8-9).

Locally stored video clips can be played in non-real time even 
without proxies available. They will be played according to the 
settings of the overlay (see section “The Video Overlay” on 
page 5-6).
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system again as soon as another file is singled out or the Spycer user 
interface is closed.

5.2.2 The Video Overlay

The video overlay at the top of the preview area allows you to preview 
data. Once a still image, 3D LUT or video clip is singled out in the 
browse and search area (e.g. with a double-click of the mouse), its con-
tents is displayed there.

With the context menu of the video overlay you can, for example, con-
figure the appearance of the video overlay or the behavior of plays fur-
ther. It provides the following menu options:

To create proxies on another system in the SpycerNet you must 
have read and write permissions on this system and the native 
Spycer application must be properly configured for the creation 
of proxies.

To preview an already available proxy in the SpycerNet only the 
browse and search permission are required.

View Displays timecode, keycode and frames informa-
tion superimposed on the video overlay. Select 
from the opening submenu the respective informa-
tion that should be displayed in the overlay. The 
enabled view shows a cross in front. While the 
frames information simply shows the current posi-
tion of the scrub bar cursor, the timecode and key-
code information are taken from the headers of the 
files. This means that, if a file without timecode 
and/or keycode information in its file header is dis-
played, no timecode/keycode will be displayed in 
the overlay.

Fit to screen Scales the video overlay to the maximum available 
width or height of the preview area. If enabled it 
shows a cross in front.

Maximize / 
Minimize 

Either maximizes the preview area, i.e. hides all 
other areas of the Spycer user interface (see section 
“Changing the Layout of the User Interface” on 
page 3-22), or restores the previous layout of the 
user interface.

This can also be performed with a double-
click of the mouse somewhere in the pre-
view area or the menu option Maximize 
Preview Area on the View menu (see 
section “The ’View’ Menu” on 
page 8-21).
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5.2.3 The Scrub Bar

If the singled-out file is a video or audio clip you can find beneath the 
video overlay a scrub bar, representing a timeline of the clip’s contents. 
With its cursor you can move within and view the content of the clip. 
Simply select the cursor with the mouse and move it along the scrub bar 
to the desired position, or click somewhere on the scrub bar to move 
the scrub bar cursor there instantly. While working with video clips and 
the scrub bar or the preview controls below, the video overlay always 
adjusts to your moves and displays the image of the selected position.

5.2.4 The Preview Controls

In addition to moving the scrub bar cursor manually, you can control it 
via the preview controls below the scrub bar, e.g. the play button. In 
detail the controls beneath the scrub bar perform the following func-
tions:

Play original With a proxy available this menu option forces the 
play of the original video material instead. If en-
abled it shows a cross in front.

Reload proxy Reloads the proxy of the clip displayed in the pre-
view area.

Force realtime This option holds the frame rate of the video clip to 
be played out, meaning the clip will be played in 
real time but, for example, when no proxy is avail-
able, frames in between may be dropped to 
achieve this. If enabled it shows a cross in front. 
When disabled, the clip will be played out frame by 
frame as fast as possible. With a container format 
such as *.mov or *.mpeg selected for a viewing 
that contains audio as well, you will hear the audio 
stream when the Force realtime option is en-
abled.

A preview can also be controlled with various keyboard short-
cuts. Further information about the available shortcuts can be 
found in section “Keyboard Shortcuts” on page A-9.

With these buttons you can step one frame for- 
or backward in the contents of the clip. The 
scrub bar cursor will move accordingly.
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5.2.5 The Status Bar

At the bottom of the preview area a status bar can be found showing 
you information about the clip and its proxy. It details, for example, 
whether a proxy clip is available for a preview, the current position of 
the scrub bar cursor in frames, and the clip’s total amount of frames.

Furthermore, when viewing clips over the SpycerNet, the status bar also 
indicates the download progress of the proxy from the foreign system 
as well as the data rate of the download:

Figure 5-4: Progress bar of a proxy download via the SpycerNet

With this button you can play the clip that is cur-
rently singled out (audio or video). The real-time 
play of a video clip and/or the playing of a clip 
in the SpycerNet requires a proxy. After activa-
tion the button changes its appearance to its ac-
tive state ( ) and you have to 
press it again to stop the play.

This button will not be available when 
a playing cannot be performed (e.g. 
with audio material stored on a foreign 
system).

Locally stored video clips can be played 
even without proxies available. They 
will be played according to the settings 
of the overlay (menu option Force 
realtime, see section “The Video 
Overlay” on page 5-6).

With this button activated a play of the clip’s 
timeline will be performed endlessly in a loop: 
Once the scrub bar cursor reaches the end of 
the clip, the play will start from the beginning 
again. To switch off the loop mode simply click 
this button again.

These buttons jump to the beginning or end of 
the clip displayed in the preview area. The first 
button jumps to the beginning of the scrub bar 
while the second button jumps to its end.
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5.2.6 How to Single out Data

To single out data and view its content in the preview area you have to 
do the following:

In the browse and search area (see chapter “Browsing and Search-
ing” on page 4-1) make the desired material available in a contents 
area by browsing or searching for it.

In case a specific image of a video clip should be displayed in the 
preview area select it with the help of the thumbnail’s scrub bar (see 
section “Previewing Data via Thumbnails” on page 5-2).

Next you have several possibilities at hand. Use either one of the 
following:

– Select the respective file with the mouse and drag and drop it 
somewhere in the metadata or preview area.

– Double-click the respective file with the mouse.
– Use the menu option Show all metadata on its context menu 

(see section “The Context Menu” on page 4-9).

This will single out the selected data and further information about it 
will be displayed in the metadata area (see chapter “Working with 
Metadata” on page 6-1). If the singled out data is either a 3D LUT, vid-
eo clip or a still image, its content will be displayed in the video overlay 
of the preview area.

5.2.7 Previewing Video Clips

As soon as video data is displayed in the preview area (see section 
“How to Single out Data” on page 5-9) you can preview it. For this you 
may use the scrub bar or the preview controls:

Move the cursor of the scrub bar to the left or right to move to a 
certain position within the clip.

Alternatively you can use the keys [Left Arrow]/[Right Ar-
row] when the preview area has the focus (e.g. after select-
ing it with the mouse).
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Figure 5-5: Preview of a clip in the preview area

Additionally you can use the preview controls (e.g. ) 
to view the contents of the clip (see section “The Preview Controls” 
on page 5-7).

The video overlay will adjust to your moves accordingly and display the 
contents of the clip.

If a proxy clip is already available for the singled out video clip (detailed 
in the status bar of the preview area), you can also preview the video 
clip in real time:

Press the play button ( ) of the preview controls.

Then the contents of the clip is shown in real time in the video overlay 
of the preview area.

The position of the scrub bar cursor also determines the file 
specific metadata that will be displayed in the header data view 
(see section “Header Data” on page 6-6).

A proxy clip can be created with the menu option Create 
proxy of the context menu of the clip in the contents area of 
the browse and search tools (see section “The Context Menu” 
on page 4-9). Further information about proxy clips can be 
found in section “General Information about Proxies” on 
page 5-5.

Locally stored video clips can be played in non-real time even 
without proxies available. They will be played according to the 
settings of the overlay (menu option Force realtime, see sec-
tion “The Video Overlay” on page 5-6).

With a container format such as *.mov or *.mpeg selected for 
a viewing that contains audio as well, you can also listen to its 
audio. For this the option Force realtime has to be enabled 
(see section “The Video Overlay” on page 5-6).

scrub bar
with cursor
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5.2.8 Previewing Audio

Audio clips can be as easily previewed as video clips: As soon as an au-
dio file is singled out (see section “How to Single out Data” on 
page 5-9) you can listen to it.

Press the play button ( ) of the preview controls to 
play the audio file.

This will play the contents of the audio file. If your computer system is 
equipped with a sound device and speakers, you will now hear the au-
dio data.

5.2.9 Previewing 3D LUTs

When a three dimensional look-up table (3D LUT, formats*.3dl, 
*.e3d and *.lut) is singled out (see section “How to Single out Da-
ta” on page 5-9), it will be displayed in the preview area with its color 
cube.

Figure 5-6: The color cube of a 3D LUT in the preview area

For a preview of audio you can use locally stored data only. A 
direct preview of this material from another system in the 
SpycerNet is not possible.

Audio from container file formats such as *.mov or *.mpeg 
can be played as well. For this the option Force realtime has 
to be enabled (see section “The Video Overlay” on page 5-6).

For a preview of 3D LUTs you can use locally stored data only. 
A direct preview of this material from another system in the 
SpycerNet is not possible.
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To view it and its color conversion results in more detail Spycer offers 
you several possibilities:

Perform one of the following in the video overlay:

– By pressing the left mouse button and moving the mouse you 
can rotate the color cube freely.

– By clicking with the scroll wheel or the right mouse button you 
can switch the output colors to the input colors and vice versa. 
The colors that are currently displayed is indicated at the top of 
the video overlay.

– By turning the scroll wheel of the mouse you can morph the 
colors in the cube from output to input and vice versa. The 
degree of the morphing is indicated at the top of the video 
overlay.

With this you can evaluate a 3D LUT easily in Spycer and see the results 
of a color conversion.
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Working with Metadata

Metadata is data about data. In the field of digital video it stands for 
further information that describe the content (footage) throughout the 
various production stages. This may include everything from the plan-
ning and pre-production stage over the actual production and post pro-
duction to the final delivery of the content. With Spycer you can add 
and edit metadata effortlessly.

If not already visible in the user interface, you can ac-
tivate the view of the metadata and preview areas of 
Spycer with the button METADATA directly below the menu bar.

Figure 6-1: The metadata area

The metadata area will show you the properties and metadata of the 
file currently singled out in the browse and search area. You can switch 

metadata controls metadata fields
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through as well as add and edit the metadata with the buttons (con-
trols) provided to the left.

This chapter describes in detail the metadata area as well as how to 
work with metadata.

6.1 Displaying Metadata

The procedure to display metadata is the same as if you want to pre-
view the material in the preview area to the right of the metadata area: 
It has to be singled out in a contents area of the browse or search tools.

To single out data and view its metadata perform the procedure 
described in section “How to Single out Data” on page 5-9.

As soon as the metadata of the selected material are displayed, you can 
switch through as well as add or edit them with the metadata controls 
(see section “The Metadata Controls” on page 6-3). When an entry is 
changed and saved, it will be stored in the file header(s) and/or in the 
data record of the respective file/sequence in the database adminis-
tered by the SpycerAgent.

For further information about the preview area please refer to 
section “Previewing Data with the Preview Area” on page 5-4.
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6.2 The Metadata Controls

After metadata are displayed in the metadata area (see section “Dis-
playing Metadata” on page 6-2) you can switch through the different 
metadata views as well as add or edit the metadata with the controls 
provided to the left. The following controls are available:

The button FILE (the first view activated when Spyc-
er is started and the metadata area is displayed) 
shows the file related metadata information in the 
metadata fields to the right of the controls. For more 
details about this metadata view see section “File 
Metadata” on page 6-5.

This view of the metadata allows you to re-
view most information only. Because they 
are properties of the singled out data they 
cannot be changed.

This button switches the view of the metadata to a 
display of the header data provided by the singled 
out material. Most file formats feature a file header 
where further information about its content are de-
tailed. In the header data view of Spycer you can get 
a look at the data as it is written in the file itself. With 
video data it will display the header data of the 
frame (image file) that is currently selected with the 
scrub bar cursor of the preview area (see section 
“Header Data” on page 6-6). Certain entries in the 
header data can be edited if supported by the file 
format, e.g. the timecode information (source time-
code). Once saved they will be directly written to 
the file(s).

Currently, only the header data of *.dpx 
files can be edited with Spycer.

With the PRODUCTION button you switch the meta-
data view to its production information. Here you 
can add or edit additional information about the 
production stages of the content.

Currently this information is provided virtu-
ally by Spycer’s database only. A change of 
the files’ headers cannot be made in this 
metadata view.

This button allows you to add or change the meta-
data as they are available in the production metada-
ta view (button PRODUCTION) or the header data 
view (button HEADER DATA). Once clicked the 
metadata can be changed.
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With the SAVE button you can save your alterations 
to the metadata. The changes will be stored in the 
file header(s) (when in the header data view and 
supported by the file format) and/or in the data 
record of the respective file in the database adminis-
tered by the SpycerAgent.

The CANCEL button discards all alterations to the 
currently active metadata view.
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6.3 Metadata Views

Spycer provides three metadata views to the metadata of the singled 
out file: file metadata, header data and production metadata. You can 
switch through the different metadata views with the upper controls 
provided to the left (buttons FILE, HEADER DATA and PRODUCTION). 
Once the button EDIT is clicked and if the respective fields are not 
dimmed, you can change their metadata. The changes will be stored ei-
ther in the file header directly and/or in the data record of the respec-
tive file with the button SAVE.

This section explains shortly the different metadata views provided by 
the Spycer user interface.

6.3.1 File Metadata

If not already displayed in Spycer activate the view of the file metadata 
with the button FILE of the controls (see section “The Metadata Con-
trols” on page 6-3).

Figure 6-2: The file metadata

When a file is singled out (see section “Displaying Metadata” on 
page 6-2), the file metadata view shows its file related information. All 
files displayed in Spycer will deliver metadata in this view: For example, 
in the area ’General File Data’ standard information about storage lo-
cation and file name are detailed. Additionally, video, audio and project 
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files supported by Spycer (see section “Supported File Formats” on 
page A-5) provide the following:

6.3.2 Header Data

You can switch to a view of the header data of the singled out material 
with the button HEADER DATA (see section “The Metadata Controls” 
on page 6-3).

Most file formats provide a file header where further information about 
its content are detailed, for example, in an image file often its height, 
width and color depth is detailed. Some file formats, e.g. *.dpx files, 
are capable of storing even more information. These information are 

This view of the metadata allows you to review most informa-
tion only. Because they are properties of the singled out file 
they cannot be changed.

Some areas of the file metadata view will alter their appearance 
and show different metadata in dependence on the selected 
file type.

video/still images Video and still image files present further details 
about their format in the area ’Image’ as well as 
timecode or keycode information in the area 
’Timecode’ when timecode and/or keycode are 
stored in the file’s headers (source timecode).

audio Audio files detail further information about their 
audio properties in the area ’Sound’.

project files Project files of a video system software by DVS 
(e.g. the CLIPSTER or the Pronto2K.2 software) 
will deliver information about their output settings 
(video format settings) as well as give a list of all 
media that are included in the project.

With the button RENAME you can change the file name(s) of 
the singled out material. Please refer to section “Renaming” on 
page 7-2 for further details.

A defragmentation of the singled out material can be initiated 
with the button DEFRAG. See section “Defragmenter” on 
page 7-4 for more information.

With the combo box Source of the area ’Timecode’ you can 
select different types of timecode to be displayed in the file 
metadata view (GENERIC: the first and last source timecode 
read from the files’ headers, KEYCODE: the first and last key-
code information read from the files’ headers, and INDEX: the 
start and stop index (first and last frame number) read from the 
file names).
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usually written in a specified format into the file headers and can be 
read and interpreted by different software applications that support 
these kind of information. Among them you can find, for example, the 
name of the creator (usually the program that created the files), the cre-
ation date and time, the timecode (so called source or generic time-
code), and/or the keycode.

In the header data view of Spycer you can get a look at the data as it is 
written in the file itself. With video clips it displays the header data of 
the file that is currently selected with the scrub bar cursor of the preview 
area. To view the header data of another video image file simply move 
the scrub bar cursor of the preview area (see section “Previewing Data 
with the Preview Area” on page 5-4) to the desired position.

Figure 6-3: The header data

At the top of the header data view you can find further information 
about the material that is singled out. At the top left the file name of 
the material is detailed. With video clips that consist of still image files 
it is the one that is currently selected with the scrub bar cursor of the 
preview area. Certain entries of the header data can be added or edited 
if supported by the file format. With the combo box Edit at the top 
right you can specify where in a video image file sequence an editing 
of the header data should be performed.

If header data can be altered, a click on the button EDIT will alter the 
view of the header data and you receive an entry mask:

Files of the formats *.lut, *.3dl, *.xml, and *.txt show 
their complete contents when viewed in the header data view.
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Figure 6-4: Changing the header data

The header data values that are detailed in this mask can be altered by 
adapting or entering a value in an entry field and activating it with its 
preceding check box. For further information about this see section 
“Altering the Header Metadata” on page 6-10.

6.3.3 Production Metadata

With the PRODUCTION button you switch the metadata view to the pro-
duction metadata (see section “The Metadata Controls” on page 6-3).

Currently, in the header data view only the data of *.dpx files 
can be edited in Spycer.
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Figure 6-5: The production metadata

In this metadata view you can add or edit additional information about 
the production stages of the content. All fields can be changed (see sec-
tion “Changing the Production Metadata” on page 6-11).

Currently the production metadata are provided virtually by 
Spycer’s database only. A changing of the files’ headers, even 
if supported by the file format, will not be triggered when 
changing or saving this metadata.
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6.4 Working with Metadata

Once material is singled out as described in section “How to Single out 
Data” on page 5-9, its metadata are displayed in the metadata area. All 
files displayed in Spycer provide metadata in the different metadata 
views. This way you can gather information from the file metadata view 
(button FILE), for instance, about the video or audio format of material 
or check the timecodes provided by a video clip with the combo box 
Source. Furthermore, you may compare these information with the 
actual header data stored in the file(s) with the help of the header data 
view (button HEADER DATA). In the production metadata view (button 
PRODUCTION) you can view its production metadata.

In the production and header data view metadata can also be added 
and edited. This section describes shortly how to add and/or edit meta-
data.

6.4.1 Altering the Header Metadata

Certain file formats of video clips also support the storing of metadata 
information in their files’ headers. Among these metadata you can find, 
for example, the name of the creator, the creation date and time, the 
source timecode, and/or the keycode.

To change the header data of an image sequence perform the follow-
ing:

Single out the video clip whose metadata you want to change as 
described in section “How to Single out Data” on page 5-9.

In case you want to alter the metadata of a specific image or image 
range, move the scrub bar cursor of the preview area to the desired 
position (see section “Previewing Video Clips” on page 5-9).

After this switch to the header data view by activating the button 
HEADER DATA.

This displays the header data of the file currently selected with the scrub 
bar cursor in the header data view. Now you can change its metadata:

Via the combo box Edit at the top right of the header data view 
select where in the file sequence an editing of the header data 
should be performed.

After this activate the button EDIT from the metadata controls.

Currently, in the header data view only the data of *.dpx files 
can be edited in Spycer.

Files of the formats *.lut, *.3dl, *.xml, and *.txt show 
their complete contents when viewed in the header data view.
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This will alter the appearance of the header data view and an entry 
mask is displayed.

Type in or alter the respective metadata information in the available 
fields.

Check whether the check boxes of the values that should be 
changed in the file header(s) are enabled.

Afterwards save the metadata with the button SAVE.

This will change the values stored in the file header(s). Depending on 
the selected file range for the changes it may take some time. When 
finished, the original header data view is restored and you can see the 
alterations in the information displayed.

6.4.2 Changing the Production Metadata

Production metadata can also be changed. They will be stored virtually 
in the database of the Spycer application:

Single out the material whose metadata you want to change as 
described in section “How to Single out Data” on page 5-9.

If not already displayed switch to the production metadata with the 
button PRODUCTION of the metadata controls (see section “The 
Metadata Controls” on page 6-3).

From the metadata controls activate the button EDIT.

This enables you to change the metadata displayed in the metadata ar-
ea.

Type in or alter the respective metadata information in the available 
fields.

Afterwards save the metadata with the button SAVE.

The metadata will be stored and written to the material’s data record in 
the database administered by the SpycerAgent. With this you can easily 
find the material again by searching for the added metadata with the 
search tool of Spycer (see section “Searching for Data” on page 4-16).

In case no entry mask is displayed when the button EDIT is ac-
tivated, an editing of the header data is not supported by the 
selected file format.

To create file names with a proper frame numbering as meta-
data for video clips you have to observe the C notation, usually 
with the syntax <string>%0Yd.<ext> (see section “The 
Search Parameter Area” on page 4-16).
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Managing Data

This chapter describes tools and instruments available in Spycer that will 
help you to manage vast amounts of data. First several smaller manage-
ment tools are described, such as the renaming of image sequences, the 
built-in defragmenter or the storage space calculator. After that follow 
descriptions of the job list and the job scheduler.
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7.1 The Management Tools

Several management tools supplement the usage of Spycer comprising, 
for example, a renaming function for image sequences, an integrated 
high-speed copying process and a sophisticated defragmentation of 
image sequences. They will be described in this section.

7.1.1 Renaming

Spycer provides a renaming tool for image sequences where you can 
easily change, for instance, the name prefixes, frame numbers or file 
extensions. When viewing the file related metadata of the currently sin-
gled out file, you can find right beside the Filename(s) entry the but-
ton RENAME (see chapter “Working with Metadata” on page 6-1). 
With it you can rename the currently singled out material.

In case the singled out material is available as a single file on the storage 
(e.g. an audio file), the button RENAME opens a dialog window where 
you simply have to enter the new name. Once the file name changes 
are confirmed with the button OK, the file will be named accordingly.

However, when the button RENAME is called for an image sequence 
consisting of still images, it opens the renaming tool of Spycer:

Figure 7-1: The renaming tool

A renaming either for a single file or a file sequence can also be 
called with the menu option Rename… on the context menu 
of a directory/file in the browse and search area (see section 
“The Context Menu” on page 4-9).
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The renaming tool of Spycer provides the following items:

Name Pattern 

Start Number 
With the check box Name Pattern you enable a 
change of the pattern of the files. Usually, this is 
used to alter the frame numbering.

Change the name pattern in the entry field below 
the check box. The hash symbols (#) indicate the 
pattern of the frame numbering. If the number of 
hash symbols exceed the number of digits of the 
frame numbering, they will be filled with zeros. 
This entry field can also be used to change the file 
names’ prefixes (same effect as ’Replace/With’).

The Start Number entry field changes the frame 
number of the first frame file (start frame). All oth-
er files will be numbered in ascending order.

Extension If activated, it will change the file extension of the 
image sequence with the term entered in the entry 
field to the right.

Case When enabled, it will change the upper and/or 
lower cases of the file names’ letters. Select the ap-
plicable alteration from the combo box to the right.

Replace 

With 

Case Sensitive 

An enabled check box of these items allows you to 
replace any string in your file names with the spec-
ified one. It works also over several occurrences. In 
the Replace field type in the string that should be 
replaced. In case the string to be replaced occurs 
several times, i.e. it is available more than once, 
you can enter it case sensitive. Then by activating 
the Case Sensitive check box you may rule out 
any other lower or upper case occurrence. In the 
field With you have to type in the replacement 
string to be inserted in the file names.

table With the table at the bottom of the renaming tool 
you can verify the result of the renaming by com-
paring the old file names with the new ones.

OK The OK button closes the renaming tool and ap-
plies the specified changes to the whole sequence 
of the video clip: All file names will be changed.

CANCEL Cancels the renaming and closes the tool without 
changing the file names.
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7.1.2 Defragmenter

Spycer provides a built-in defragmenter especially designed to optimize 
the physical alignment of image sequences (video clips) on storages so 
that they are more suited for real-time operations.

The alignment of clips on a storage is of special importance when per-
forming real-time operations with clips in HD or larger: The perfor-
mance of the hard disk(s) is limited and may soon be reached, especially 
when the storage contains large amounts of data. Then, a real-time op-
eration (play-out or record) may get interrupted due to the facts that 
files are stored in segments or even fragments on the hard disks and 
disk drives tend to get slower the fuller they are. With the built-in de-
fragmenter you can defragment any file that is fragmented and, fur-
thermore, align image files of video clips contiguously in larger blocks 
on the storage which will minimize access times during read proce-
dures.

With Spycer you can defragment either single files/clips or several ones 
in one step. To defragment more than one file/clip you can either select 
several ones in a contents area of the browse and search tools or de-
fragment the directory or drive that contains them.

The following details how to assess the defragmentation degree and 
how to initiate a defragmentation.

Assessing the Defragmentation Status

The defragmentation status of a file/clip can be seen in the browse and 
search area as well as in the file metadata view of the metadata area.

The built-in defragmenter uses proprietary routines to defrag-
ment the data on the storage. The results will not be the same 
when using a third-party defragmentation tool, because it will 
not heed image file sequences. Therefore, do not use any oth-
er defragmentation tool than the ones from DVS for a defrag-
mentation of a video storage.

It is recommended to defragment storages at regular intervals, 
even with lesser amounts of data stored on them. Then, newly 
copied or captured material can be better positioned on the 
storage and later defragmentation runs have less to deal with.

To run the defragmenter on an SNFS storage you must log on 
to the computer system with administrative rights for the stor-
age.

With a Spycer that supports SNFS (see section “Program Vari-
ants of Spycer” on page 1-5) you can also optimize the free 
space of a storage. For this initiate a defragmentation of the 
complete drive/volume. Works only on SNFS storages.
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In the browse and search area you can find this information in a con-
tents area once a file is displayed (see section “The Contents Area” on 
page 4-6). The text information provided by the file will detail this in-
formation (either to the right of a thumbnail or when in its text infor-
mation view) under the entry ’Defrag’:

Figure 7-2: Contents area showing the defragmentation status

Additionally, it can be seen in the metadata area (see chapter “Working 
with Metadata” on page 6-1) when an entry in Spycer is singled out 
and the file metadata is visible. You can find the defragmentation de-
gree under the entry ’Defragmented’ among the general file data.

Figure 7-3: File metadata showing the defragmentation status

defragmentation
status

defragmentation
status
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In Spycer the defragmentation status of a file or clip is indicated with 
the help of colors and percentage values:

Initiating a Defragmentation

A defragmentation can be started in the metadata area with the file 
metadata view selected or via the browse and search area. Even files of 
unknown formats are defragmented by the defragmenter of Spycer. To 
initiate a defragmentation perform either one of the following:

– To initiate a defragmentation from the metadata area:
With the metadata of the file or clip displayed in the file metadata 
view of the metadata area select the button DEFRAG.

– To initiate a defragmentation from the browse and search area:
Browse or search for the respective file/clip. When it is displayed in 
a contents area select from its context menu the menu option 
Defragment (see section “The Context Menu” on page 4-9).

This will start a defragmentation of the selected data and an entry in 
the job list is created (see section “The Job List” on page 7-12). The job 
entry also shows a progress bar for the defragmentation process. As 
long as the defragmentation is under way the system will have the sta-
tus ’busy’ (see section “The Status Bar” on page 4-9).

Furthermore when in the browse and search area, you can defragment 
more than one file/clip with a single step:

Color Percent Explanation

blue 100% The file/clip is optimally aligned on the storage 
and none of its data is fragmented.

– 1% - 99% The clip exists in segments but none of its files 
are fragmented.

red 0% The file or at least one image of a clip is stored in 
fragments on the storage. If this is the case with 
a video clip, it may cause problems during play-
out operations, depending on its resolution and 
file sizes.

Segmentation: A clip is segmented when its image files are not 
aligned contiguously in larger blocks on the hard disk array but 
scattered over the storage.

Fragmentation: Either a file is fragmented or a video clip con-
tains fragmented files. In contrast to segmentation here it is the 
data of a single file that is scattered over the storage.
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– You can select several individual ones when displayed in a contents 
area, for example, by holding down the [Ctrl] key (Mac: [ ]) while 
selecting them with the mouse.

– You can select a directory or volume that contains these clips in the 
directory tree of the browse area, which will defragment all files 
stored at this location (files in subdirectories as well).

Then initiate the defragmentation with the menu option Defragment 
from the context menu (see section “The Context Menu” on 
page 4-9).

As long as the defragmentation is in progress, the system will have the 
status ’busy’. Depending on the amount of data to be defragmented 
this process may take a while. The defragmentation operation ends au-
tomatically as soon as all selected data is processed. Then the files/clips 
will be perfectly aligned on the storage and show a defragmentation 
status of 100% (blue).

7.1.3 High-Speed Copying

To copy vast amounts of video material from one storage location to 
another is often a time consuming procedure when performed with the 
standard tools of an operating system, such as a file manager. To do this 
faster DVS integrated in Spycer a high-speed copying routine which 
deals with such tasks in about four times the speed of a standard oper-
ating system copy.

The high-speed copying tool is truly integrated in Spycer: It will be 
started and used as soon as a copying or moving is performed (see sec-
tion “Copying (Moving) Directories/Files” on page 4-13).

With the search tool you can search for a defragmentation 
degree. Once displayed in the contents area of the search 
results, the entries can be selected and then defragmented.

With a Spycer that supports SNFS (see section “Program Vari-
ants of Spycer” on page 1-5) you can also optimize the free 
space of a storage. For this initiate a defragmentation of the 
complete drive/volume. Works only on an SNFS storage.

The copying/moving can also be combined with an automatic 
defragmentation of the copied or moved material. For further 
information about how to set this please refer to section “The 
Group ’Jobs’” on page 8-9.
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7.1.4 File Format Converter

Spycer provides an integrated file format converter able to convert still 
images as well as complete video clips to another file format. Whether 
you want to convert, for example, a video clip in a container format to 
an image file sequence or vice versa, this tool deals with such tasks ef-
fortlessly. It can be accessed from the context menu of image or video 
data displayed in the browse or search area:

In the browse and search area (see chapter “Browsing and Search-
ing” on page 4-1) browse or search for the still image or video clip 
that should be converted.

Then select from its context menu the menu option Convert… (see 
section “The Context Menu” on page 4-9).

This will open the window of the file format converter of Spycer:

Figure 7-4: The file format converter of Spycer

The source settings, i.e. details about the material that should be con-
verted, are displayed in the upper part of the window. The lower part 
determines its destination, i.e. such things as name, file format or reso-
lution. The following items are provided:

Source Indicates the directory and path to the source ma-
terial. It is already set to the video/image data 
where the file format converter was called.

Inpoint Allows you to select a different inpoint for the 
conversion. The conversion will start with the im-
age of this frame number.
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Duration Determines the length of the converted clip, i.e. 
how many frames to convert from the inpoint on-
wards. Its maximum value can be:
<last frame no.>-<inpoint>+1.

Destination Path The path to the directory where the converted 
file(s) will be stored. To set a path you may either 
type in a path in the entry field or use the button 
to the right ( ) to select one via the opening di-
alog window.

Destination Name The name of the converted file(s). To create file 
names with frame numbers you have to observe 
the C notation, usually with the syntax 
<string>%0Yd.<ext> (see section “The 
Search Parameter Area” on page 4-16).

Start Index Available for clip formats that consist of still imag-
es: Allows you to select the start index of the clip, 
i.e. determines the frame number in the file name 
of the first converted frame.

File Format Determines the file format of the final material. 
The respective extension will also be indicated in 
the field Destination Name.

Codec If the selected file format requires a codec it can 
be selected with this combo box. Whether this 
setting will be available depends on the selected 
file format.

Resolution With this field you can determine the video for-
mat of the material to be created. Either select 
from its drop-down list one of the predefined vid-
eo formats or set it to custom to define the res-
olution yourself.

Width Details the width of the material to be created in 
pixels. If Resolution is set to custom it can be 
adjusted freely.

Height Details the height of the material to be created in 
pixels. If Resolution is set to custom it can be 
adjusted freely.

Pixel Ratio Determines the pixel aspect ratio that should be 
applied during the conversion. Whether this set-
ting will be available depends on the selected file 
format.

Aspect Available for informatory reasons. It details the 
aspect ratio of the set video format, i.e. the ratio 
of Width to Height.
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To perform a conversion do the following:

With the settings items in the window of the file format converter 
configure the conversion.

Then initiate the conversion with the button OK.

This will write the converted material to the destination directory and 
an entry in the job list is created (see section “The Job List” on 
page 7-12). The entry in the job list also shows a progress bar of the 
conversion process. As long as it is under way the system will have the 
status ’busy’ (see section “The Status Bar” on page 4-9). If the original 
video/image format of the material differs from the destination format, 
the image(s) will be skewed accordingly so that they fit optimally in the 
new format. After the conversion the source file(s) are not deleted but 
remain at their location for further use.

7.1.5 Calculator

With the calculator of Spycer you can calculate from a set video format 
its maximum recording time (by a given amount of storage capacity) or 
the required storage (by a given duration of video data). It can be ac-
cessed from the menu bar of Spycer:

From the menu bar of Spycer (see section “Overview of the User 
Interface” on page 3-16) select Tools » Calculator….

This will open the calculator of Spycer:

Frame Rate Sets the frame rate of the converted material. 
Whether this setting will be available depends on 
the selected file format.

Scaling Quality For the conversion you can select between three 
scaling qualities. It also effects the speed of the 
conversion. For example, the setting high will 
yield the best quality but will also take longest to 
process.

OK The OK button closes the file format converter 
and converts the material according to the set-
tings.

CANCEL Cancels the conversion and closes the file format 
converter.
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Figure 7-5: The calculator of Spycer

With the upper settings you determine the video format. Once the vid-
eo format is set, the calculation will be straight forward:

Select the video format from the settings items by choosing the 
appropriate values.

Next you have two possibilities at hand:

– To determine the maximum length of the video data by a given 
storage capacity enter in the field Size the storage space, or

– enter in the field Duration the duration of the video data if you 
want to know the required storage space. It has to be entered 
in timecode format without frames (hh:mm:ss)

The calculation will be made as soon as an entry is changed: The re-
maining value will adjust itself automatically. Once you are finished 
with the calculation(s), the window of the calculator can be closed with 
the button CLOSE.

With the radio buttons to the right of the fields Size and Du-
ration you can also determine the way a calculation is per-
formed: To calculate from a given storage to a duration the 
Duration radio button has to be selected, and vice versa.

A similar calculation regarding disk spaces of a selected storage 
can be done in the properties window of a drive or directory 
(see section “The Properties Window” on page 8-2).



7-12

Spycer User Guide

7.2 The Job List

The job list of Spycer provides information about jobs 
that are performed on your system or that you have 
initiated on other systems in the SpycerNet. Additionally, these jobs can 
be controlled from here, for example, by canceling them. You can 
switch to the job list of Spycer with the button JOB LIST directly below 
the menu bar.

Figure 7-6: The job list of Spycer

The job list shows tasks that are concerned with your system: either 
they were triggered from or are carried out on your system. Addition-
ally, it details only those tasks that may render a system ’busy’ (see sec-
tion “The Status Bar” on page 4-9). Whenever such a task is triggered, 
an entry can be found here. For example, if you start a defragmentation 
on another system in the SpycerNet (see section “Defragmenter” on 
page 7-4) or re-scan your watched folders (see section “The Context 
Menu” on page 4-9), or someone else in the SpycerNet starts a task on 
your system, it will be noted here. Furthermore, as long as the task is 
not finished, each entry informs you about its progress in the last col-
umn of the list, for example, with the help of a progress bar. Then, it 
may detail the time remaining, its progress in percent and the data rate:

Figure 7-7: Job in progress

When the job list is not activated and visible, arriving jobs are 
indicated by a (three times) flashing JOB LIST button.
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In detail the table of the job list provides the following information:

The jobs in the job list are listed in the order they were initiated from 
top to bottom, i.e. the latest jobs are listed at the bottom of the job list. 
When several jobs are started on a system, they will be processed one 
at a time in the sequence stated in the job list. Jobs that wait for a task 
to finish have the state ’pending’.

With the buttons below the job list you can control the list as well as 
running and pending jobs. To select a job simply click on its entry in the 
job list (see also section “Keyboard Shortcuts” on page A-9):

Column Explanation

No. Number of the listed job.

Created by Details the system that triggered the task.

Job Type The type of job that has been triggered is stated in 
this column, e.g. copy, dvscopy, move, delete, 
scan, etc. If the job type appears with auto ... 
in front, it was initiated by the scheduler of Spycer 
(see section “The Scheduler” on page 7-14).

Src. Peer The source peer. Details the source of the data in 
the SpycerNet, i.e. the name of the system where 
the source data is stored.

Source States the location of the source files on the source 
peer.

Dest. Peer The destination peer. Details the destination of the 
data in the SpycerNet, i.e. the name of the system 
where the data is to be transferred to.

Destination Details the target directory on the destination 
peer.

Status Indicates the state of the respective job, such as 
paused, running, canceled, finished, failed, etc.

Progress Informs you about the progress of the job. Pro-
cesses that take longer are displayed with the help 
of a progress bar (see above).

PAUSE SELECTED Pauses the selected job(s).

RESUME SELECTED Either continues a paused job or starts a pending 
one.

CANCEL SELECTED Cancels and aborts the selected job(s).

REFRESH LIST Clears the table, running and pending jobs will 
be detailed again.
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7.3 The Scheduler

The scheduler enables you to initiate tasks at certain 
times or intervals automatically, for example, for man-
agement and maintenance operations in your SpycerNet. You can 
switch to the scheduler of Spycer with the button SCHEDULER directly 
below the menu bar.

Figure 7-8: The scheduler of Spycer

The scheduler allows you to perform, for example, copy, defragment or 
delete tasks regularly (e.g. defragmenting larger storages at nighttimes 
or weekends when no one is working) or at defined times just once.

Scheduled jobs are administered by the SpycerAgents in the SpycerNet, 
i.e. by the background processes where the respective task is targeted 
at (the destination system). Thus, to run scheduled jobs the user inter-
face of Spycer can be closed, because it will be the background process-
es that carry out the tasks.

Once a scheduled job is started, it will be performed according to the 
settings made in the scheduler. It will be detailed in the job list of each 
Spycer application involved in the task (i.e. the creation, target and des-
tination systems) with the respective job type and an added auto ... 
in front. In case you do not have the appropriate rights on the target 
and/or destination system(s), you will be either informed about this 
when creating the job in the scheduler, or an access to the system will 
be denied at the time when the job is started which will call up a noti-
fication then.

The following explains the scheduler of Spycer in more detail.
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7.3.1 Managing Scheduled Jobs

At the top of the scheduler you can find some items that allow you to 
manage scheduled jobs. With them you can determine easily either for 
the whole SpycerNet or a specific system the jobs that are scheduled to 
be performed, enabling you, for instance, to identify and (with appro-
priate permissions) edit redundant or contradicting jobs.

Figure 7-9: Items to manage scheduled jobs

The combo box Select allows you to select destination peers. By select-
ing a specific system in the SpycerNet from its list you can find out 
which jobs are scheduled on this system. They will be detailed in the list 
of the scheduler. When the entry Network is selected all jobs that are 
currently scheduled in the SpycerNet will be listed.

With the check box show editable only you can hide from the list the 
entries that you do not have the appropriate rights to edit. Afterwards 
only the entries that can be changed are displayed.

Once you have found a job that you want to change use the list and 
the items below it to edit the schedule (see section “The Scheduler’s 
List” on page 7-15 and section “Creating and Editing Scheduled Jobs” 
on page 7-16).

7.3.2 The Scheduler’s List

The list of the scheduler details the scheduled jobs according to the set-
ting of the Select combo box (see section “Managing Scheduled Jobs” 
on page 7-15). It provides the following information:

Column Explanation

Job Type Specifies the type of job that is scheduled to be 
performed, e.g. copy, delete, defrag, etc.

Created by Details the system that created the entry in the 
scheduler.

Src. Peer The source peer. Details the source of the data in 
the SpycerNet, i.e. the name of the system where 
the source data is stored.

Source States the location of the source files on the source 
peer.
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The entries in the scheduler are listed in the order they were entered 
from top to bottom, i.e. the latest entries are listed at the bottom of the 
list. A scheduled job can be selected with a single click of the mouse and 
a double-click automatically opens the window to edit an entry (if you 
have the appropriate rights, see section “Creating and Editing Sched-
uled Jobs” on page 7-16.

7.3.3 Creating and Editing Scheduled Jobs

With the buttons below the list you can create new or edit already ex-
isting scheduled jobs.

New Jobs

The button NEW allows you to create a new scheduled job. It opens the 
following window:

Figure 7-10: Window to create a new scheduled job

Dest. Peer The destination peer. Details the destination of the 
data in the SpycerNet, i.e. the name of the system 
where the data is to be transferred to. If empty a 
job is selected that does not require a destination.

Destination Details the target directory on the destination 
peer. If empty a job is selected that does not re-
quire a destination.

Start Indicates the interval, date and time of the event. 
In case of intervals, a date refers to the day when 
the task is carried out for the first time.

Duration Details how long to perform the job.

Column Explanation
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Then use the items as described as below to define the job:

Job Type Select from the combo box the type of job that 
should be performed, e.g. copy, delete, defrag-
ment, etc.

Source Once a source is defined, i.e. the path to the di-
rectory where the data to be processed is stored, 
it is detailed here. You can set the source with the 
button to the right of the entry field ( ). It 
opens a window where you can select drives and/
or directories on systems in the SpycerNet. How-
ever, only those systems will be listed where a 
Spycer of at least version 1.3 is running.

Destination This field will be available when a job is selected 
that requires a destination (e.g. copy). It details 
the target directory in the SpycerNet where to 
store the processed data. You can set it with the 
button to the right of the entry field ( ). It will 
open a window where you can select drives and/
or directories on systems in the SpycerNet. How-
ever, only those systems will be listed where a 
Spycer of at least version 1.3 is running.

Start These items determine the interval, date and time 
when to start the job:

The first combo box is available for a future adap-
tation of Spycer and can be disregarded currently.

With the second combo box you can set the in-
terval when to perform the job (e.g. Single 
Event, Daily, Weekly, etc.). You can also de-
fine an interval of your own according to your 
needs (Custom Interval).

Use the available date (yyyy-mm-dd) and time 
(hh:mm:ss) fields to set the day when the task 
should be performed (in case of intervals when it 
should be carried out for the first time) and the 
time when to start the job.

Duration Determines how long to perform the job: You can 
set it to auto (process until the task is finished) or 
a defined time (process for hh:mm:ss, then 
stop).

SAVE Saves and closes the window to configure a 
scheduled job and creates a new entry detailing 
the job in the list of the scheduler.

CANCEL Cancels the creation of a new job and closes the 
window.
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Editing Jobs

Via the buttons DELETE and EDIT you can edit the tasks displayed in the 
scheduler.

By selecting an entry in the list of the scheduler and pressing the button 
DELETE the respective task will be deleted. However, you can only de-
lete scheduled jobs that were created by your Spycer application.

With the button EDIT you can change an existing job. For this select the 
scheduled job in the list and press the button edit (alternatively double-
click the job in the list) which will open the window to change a job:

Figure 7-11: Window to edit a scheduled job

Then you can edit the respective job. The window provides the same 
items as the window to create a new scheduled job (see section “New 
Jobs” on page 7-16).

An editing can be performed when one of the following conditions is 
the case:

– The source is stored on your system.
– Your system is the destination.
– Your Spycer application created the job entry in the scheduler.

The type of job cannot be changed when editing a job. For this 
you have to delete the scheduled job and create a new one.
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Miscellaneous

This chapter details other items of the software, such as the properties 
window or the configuration settings available for Spycer. Additionally, 
it provides a reference to its menu bar, a description of some mainte-
nance tools and tasks that may be useful when experiencing problems 
with the Spycer application and a short reference to the command line 
options to control Spycer from a command line.
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8.1 The Properties Window

With the menu option Properties… on the context menu of a file, di-
rectory or drive visible in the browse and search area (see chapter 
“Browsing and Searching” on page 4-1) you can call up the properties 
of the respective item. They will be shown in the properties window:

Figure 8-1: Example of a ’Properties’ window

At the top of the window you can find information about the item’s 
name, the type of data and its storage location.

However, depending on the data type of the item where the properties 
are called, the properties window will look differently beneath these in-
formation and provide other details:

Data Type(s) Shown Properties

systems When called on systems, the properties will detail 
further information about this system, such as its 
hardware, operating system, the Spycer version 
running, and the permissions that you have on the 
respective system.
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The properties window can be closed at any time with the button 
CLOSE at the bottom of the window.

volumes
directories

When called for volumes or directories you can 
find further details about the storage where the 
item is located as well as about its capacity. De-
tailed are, for example, the free, used and total 
disk space in binary multiples of their sizes (binary 
prefixes). Additionally, time values are provided to 
show you, for instance, the amount of free space 
available for a record of video. Because these de-
pend on a video raster, you can configure raster 
settings in this view of the properties window as 
well. The time values of the disk spaces will be 
changed accordingly:

Figure 8-2: Time calculation settings for disk spaces

Furthermore, a bar is available that tells you 
graphically as well as via a percentage value the 
amount of disk space currently used on the drive 
where the item is stored.

Storage capacities are indicated as they 
are truly available, meaning they are de-
tailed without the deduction of a safety 
margin necessary to ensure the real-time 
capability on a DVS video system.

files
clips

When called for files or video clips, the properties 
window will provide various metadata informa-
tion in a table, such as file size, file name and its 
format. Additionally, depending on the type of 
file, it may as well detail such things as number of 
audio channels, audio samples, color mode, as-
pect ratio, field mode, resolution, and so on.

When accessing properties of items on other systems in the 
network, question marks (’?’) may appear instead of proper-
ties. Then give Spycer time to update the information. During 
this the properties window may remain open and once the data 
has been gathered they will be displayed.

Data Type(s) Shown Properties
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8.2 Configuring Spycer

This section describes the general configuration settings of Spycer. 
Among them you can find, for instance, the remote access permissions 
and the network configuration settings.

8.2.1 Accessing the Configurations and Overview

To set any of the general configuration settings of Spycer you have to 
access them first. For this perform the following:

From the menu bar of Spycer (see section “Overview of the User 
Interface” on page 3-16) select Options » Config….

This will open the general configuration settings of Spycer:

Figure 8-3: Starting screen of the configuration settings

Because most of these settings have already been set during 
the initial setup procedure, the following provides a description 
of the settings items only. For any further information about 
the settings please refer to section “Initial Setup of Spycer” on 
page 3-9.

group list

settings pane
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The window to set the general configurations provides the following 
items:

8.2.2 The Group ’File Transfer Ports’

The group File Transfer Ports allows you to configure further net-
work ports that should be used exclusively for file transfers (e.g. copy-
ing procedures). By adding them to the list box on the right you can 
improve the data transfer rate of your Spycer when copying or moving 
files to or from other Spycer applications in the SpycerNet.

These network connections will be used for file transfers only and op-
erate in combination with the already existing network connection to 
the SpycerNet.

group list On the left side of the configuration window you can 
find a group list that provides access to the different 
settings. They will be valid for the Spycer software in 
general. Once an entry in the list is selected, the set-
tings pane to the right will alter its appearance and the 
configuration items of the respective group are dis-
played. You can then change the settings of this group.

settings pane The settings pane shows the settings that are available 
under the selected group (group list to the left). To 
change the settings alter the configurations in the set-
tings pane and confirm your alterations with the OK 
button.

RESET A click on this button resets all values back to the last 
confirmed settings.

OK This button confirms your alterations to the settings in 
the configurations window and closes it. Then the new 
settings will be in effect. They will be saved when the 
Spycer user interface is closed (see section “Exiting the 
Software” on page 3-23).

CANCEL The button CANCEL closes the window for the general 
configuration settings without confirming your set-
tings. The Spycer application will use the latest con-
firmed settings.
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Figure 8-4: The settings items of the group ’File Transfer Ports’

The group File Transfer Ports provides the following settings items:

Only active network connections will be displayed. When a 
network connection is inactive (e.g. no cable connected), its IP 
address will not be available.

Available Ports In this list box you can find the available addi-
tional network connections. Select the ones that 
should be used for file transfers and move them 
to the list box to the right with the appropriate 
button.

All available additional ports that are 
currently active will be listed, regard-
less whether they can connect to an-
other Spycer application or not.

Selected Ports This list box details the additional network con-
nections that will be used for file transfers. To re-
move a port from the list select one and press 
the appropriate button to move it to the left list.

These buttons move the selected ports from the 
left list box to the right, or vice versa.
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8.2.3 The Group ’General’

With the group General you configure the networking and local con-
tent management of Spycer.

With the network settings you determine the connection of your Spycer 
application to the SpycerNet as well as its appearance in the network.

The local content management will be administered by the background 
process SpycerAgent. When it is enabled, the SpycerAgent will write in-
formation about the contents of the watch folders (see section “The 
Group ’Watch Folders’” on page 8-15) into a database, making it avail-
able to your Spycer application as well as to others in the SpycerNet (if 
applicable and permissions are given). Afterwards the watch folders will 
be monitored and the database will be revised once file processes are 
detected.

Figure 8-5: The settings items of the group ’General’

When a local content management is disabled, Spycer will not 
display any local drives or storages. Then the user interface can 
be used as a network browser showing the contents of other 
Spycers in the SpycerNet only.
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In the group General you can find the following settings items:

combo box 
’IP address’

Select from this combo box the IP address, i.e. 
the network connection, that Spycer should use 
to connect to the SpycerNet. The localhost ad-
dress (127.0.0.1) disables the network connec-
tion for Spycer. Afterwards it can be used locally 
only.

REFRESH This button refreshes the IP addresses available 
in the combo cox. IP addresses are gathered 
from currently active network connections. 
When a network connection is inactive (e.g. no 
cable connected), its IP address will not be dis-
played. Then establish a network connection at 
the respective connector and click the REFRESH 
button which will make its IP address available 
in the drop-down list of the combo box.

entry field 
’hostname’

In this entry field type in the name that should 
be used for your system when appearing in the 
SpycerNet. You can assign any name you want 
(special characters as well). To take the entry 
into effect you have to press the button SET 
HOSTNAME.

SET HOSTNAME This button activates and sets the name that is 
entered in the entry field to the left for the home 
system (host). The system will then use this 
name in the SpycerNet.

Status message Details the current state of the background pro-
cess SpycerAgent.

Enable local con-
tent management 
(SpycerAgent) 

With this radio button activated the local con-
tent management will be enabled. It installs and 
starts the background process SpycerAgent al-
lowing you to view local drives and search 
through the material stored in the watch folders. 
For this a database is written that is used by the 
Spycer user interface to display data. Addition-
ally it is visible and usable for other Spycer appli-
cations in the SpycerNet (if applicable and 
permissions are given).
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8.2.4 The Group ’Jobs’

The group Jobs contains some settings concerned with jobs performed 
by the SpycerAgent, most notably the proxy file settings.

ADVANCED… The background process SpycerAgent may not 
be able to access drives that need a particular 
user account (usually administrative account). 
Background processes generally run with the se-
curity context of the local system account which 
is a predefined account used by background 
processes. To enable accesses of the Spycer-
Agent to specially secured locations enter the 
appropriate user name and password (if applica-
ble) in the window that opens when the AD-
VANCED… button is pressed. On a SAN this is 
normally not necessary when a global super 
user is configured on the metadata server.

Use these settings only if you experi-
ence access permission issues that can 
be traced back to the SpycerAgent.

Windows only: For this make sure that 
the respective user has the right to ful-
ly access the background process (see 
Administrative Tools » Local Secu-
rity Policy » Local Policies » User 
Rights Assignment » Log on as a 
service).

Disable local con-
tent management 

This radio button disables the local content 
management. It will stop and deinstall the back-
ground process SpycerAgent. Then Spycer can 
be used as a network browser only, showing 
you the contents of other Spycers in the Spycer-
Net.

For further details about the SpycerAgent please refer to sec-
tion “SpycerAgent” on page 2-6. For further details about net-
working see section “Notes about Networking with Spycer” on 
page 2-9.
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Figure 8-6: The settings items of the group ’Jobs’

In detail the group Jobs provides the following settings items:

Path for proxy files Determines the location on the storage where 
the proxy files will be stored. At this location the 
directory structure of the watch folders where 
the clip is originally stored is reproduced which 
makes an identification of the proxy clips easy.

Temporarily downloaded proxy clips are 
not stored here but in one of the system 
folders (see section “Interesting Files 
and Folders” on page A-10).

Preview proxies Activates the proxy generation. When the check 
box is enabled, proxies can be generated on 
your system. Then the configuration items for 
the proxies will be available and can be set. If 
the check box is disabled, a proxy creation can-
not be performed on your system.

Resolution Details the resolution of the proxies in width and 
height (in pixels). This setting will be available 
when Preview proxies is enabled.

File format Select from this combo box the file format of the 
container file that will be used to create the 
proxies. This setting will be available when Pre-
view proxies is enabled.
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8.2.5 The Group ’Network Drives’ (Windows Only)

The group Network Drives is available under Windows operating sys-
tems only and enables you to access mounted (mapped) network drives 
in the user interface of Spycer. They are then displayed as any other lo-
cally available drive/directory that is not defined as a watched folder 
(see section “The Directory Tree” on page 4-3) and can be accessed as 
such (see section “SpycerAgent” on page 2-6).

Scaling quality For the proxy generation you can select be-
tween three scaling qualities. It also effects the 
speed of the creation. For example, the setting 
high will yield the best quality but will also take 
longest to process. This setting will be available 
when Preview proxies is enabled.

Default frame rate Sets the default frame rate of the proxy files. 
This setting will be available when Preview 
proxies is enabled.

Automatic proxy 
file generation 

When this check box is enabled, proxy files are 
generated automatically on your system as soon 
as new clips are detected by the SpycerAgent. If 
it is disabled, proxies can only be created manu-
ally with the menu option Create proxy (see 
section “The Context Menu” on page 4-9). This 
setting will be available when Preview proxies 
is enabled.

Automatic 
defragmentation 
when copy 

With this check box you configure the Spycer 
application to perform a defragmentation auto-
matically on the processed material when a copy 
process is started on your system. This will be 
valid even if the job is triggered by another 
Spycer in the SpycerNet.

Automatic 
defragmentation 
when move 

With this check box you configure the Spycer 
application to perform a defragmentation auto-
matically on the processed material when a 
move process is started on your system. This will 
be valid even if the job is triggered by another 
Spycer in the SpycerNet.
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Figure 8-7: The settings items of the group ’Network Drives’

The group Network Drives provides the following items:

list The list details the network drives that are cur-
rently mounted in your operating system. The 
column ’Drive’ details the drive letter, while the 
column ’Source Path’ indicates the path to the 
drive/directory in the network.

Mount network 
drives 

This check box mounts the network drives de-
tailed in the list above and, once confirmed, 
they will be displayed in Spycer. For this you 
have to enter the correct password that allows 
you access to the network drives in the entry 
field Password below.

The network drives will also be mounted the 
next time Spycer is started. However, then a 
message window will appear right after the 
starting of the user interface where you have to 
legitimize your access again, i.e. you have to en-
ter the correct password once more:
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8.2.6 The Group ’Permissions’

With the group Permissions you set the remote access permissions, 
i.e. you configure a remote control of your Spycer application. It may 
be useful if other Spycer applications in the SpycerNet should have ac-
cess to your system, and with these settings you determine what other 
peers are allowed to do on your system.

Figure 8-9: The settings items of the group ’Permissions’

Figure 8-8: Accessing network drives during start-up

User Details your current user name that will be used 
to mount the network drives.

Password In this entry field you have to enter the correct 
password that in combination with the user 
name allows you to access the network drives.
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The following settings items are provided:

8.2.7 The Group ’Scan Filter’

This setting allows you to determine file formats that should not be dis-
played by Spycer as image sequence files, even if their file names are 
identical and contain a numbering. It sets a filter for the scanning pro-
cess of the SpycerAgent.

The scanning process of the SpycerAgent treats all file formats as po-
tential image sequence files. Thus, when files are stored in one directory 
with identical names (e.g. prefixes) and a numbering (frame number), 
they will be displayed as a video sequence, i.e. generate a single entry 
in the database and be displayed in Spycer with a single entry as well. 
To exclude files from being treated as file sequences their file format 
should be entered in the list of the group Scan Filter.

User & Groups In this pane select the user or group that you 
want to specify the remote access permissions 
for. 

Currently only the default user group is 
available.

Remote Access 
Permissions 

Under this pane you can set the permissions of 
the user/group that has been selected in the 
pane User & Groups. For a detailed list of the 
access permissions and what they indicate see 
section “Remote Access Permissions” on 
page 3-14.

SELECT ALL This button enables all check boxes in the pane 
Remote Access Permissions in one step.

DESELECT ALL This button disables all check boxes in the pane 
Remote Access Permissions in one step.

For further information about these settings see section “Re-
mote Access Permissions” on page 3-14 and section “Notes 
about Networking with Spycer” on page 2-9.
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Figure 8-10: The settings items of the group ’Scan filter’

The following settings items are provided by the group Scan Filter:

8.2.8 The Group ’Watch Folders’

With the settings items of the group Watch Folders you determine the 
locations that will be watched by the background process SpycerAgent 
(see section “The Group ’General’” on page 8-7). The data that is 
stored there will be available for a local content management (e.g. dur-

list The list determines the file formats by their ex-
tensions (column ’Format’) that Spycer should 
not try to recognize as video clips. The entries 
can be revised by simply double-clicking an en-
try and altering it.

ADD This button adds an empty entry in the list 
above. Then type in the extension of the file for-
mat that Spycer should observe file by file.

REMOVE This button deletes entries from the list: Select 
an entry in the list and delete it by clicking the 
button REMOVE.
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ing search procedures) to your Spycer application as well as to others in 
the SpycerNet (if applicable and permissions are given).

Figure 8-11: The settings items of the group ’Watch Folders’

To set up the watch folders the following settings items are provided:

Network drives and important system drives/directories cannot 
be selected as watch folders.

The SpycerAgent registers all events that take place in the 
watch folders. To minimize the overall traffic for the Spycer-
Agent it is recommended to include directories/drives that con-
tain video/audio material only.

list The list details the specified folders (column 
’Path’), whether they are included or excluded 
in the watched folders (’Type’) and the current 
state of the included folders (’Status’).

INCLUDE FOLDER… This button opens a dialog window where you 
have to select a directory. Choose with it the 
drive/directory that should be included in the 
watched folders.
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The list provided by the group Watch Folders implicitly details three 
states of the folders if a local content management is enabled. The fol-
lowing shortly summarizes their effects:

EXCLUDE FOLDER… Excludes a drive/directory from being displayed 
in Spycer. Usually the exclusion of a specific di-
rectory is made to save it from being scanned 
into the database (as a subdirectory of an in-
cluded folder). However, with this you can ex-
clude any drive/directory whereupon they will 
not be displayed in Spycer. A click on this button 
opens a dialog window where you can select the 
drive/directory that should be excluded.

REMOVE The included and excluded folders can be re-
vised with this button: Select an entry in the list 
and delete it by clicking the button REMOVE.

State of Watched 
Folder Effect

included – Scanned by the background process and 
written to the database

– Displayed almost instantaneously in the user 
interface

– Can be searched with Spycer
– Displayed and usable in the SpycerNet (if 

applicable and permissions are given)

not detailed in list – Other local drives and directories
– Not scanned by the background process and 

not written to the database
– Displayed in Spycer only when accessed
– Not displayed in the SpycerNet
– File-based processes are allowed

excluded – Not scanned by the background process and 
not written to the database

– Not displayed in the user interface of Spycer 
or the SpycerNet
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8.3 Menu Bar Reference

At the top of a stand-alone Spycer application you can find a menu bar. 
It provides access to functions and tasks of an administrative nature to 
the Spycer application. Here you can find, for example, its configuration 
settings as well as several tools.

This section provides a reference to its menu bar. All menus and menu 
options will be explained briefly.

8.3.1 The Menu Bar on Mac OS

The menu bar as it is explained in the following sections is not available 
on Mac systems. Instead the individual menu options can be found in-
tegrated in the standard program menu bar.

Figure 8-12: The program menu bar of Mac OS

This section details where to find the menu options compared to the 
Linux/Windows versions of the software:

This section explains the menu bar as it is available on Win-
dows and Linux. For a reference where to find the individual 
menu options on Mac systems see section “The Menu Bar on 
Mac OS” on page 8-18.

Location on Linux/Windows Location on Mac OS

Spycer » Full screen View » Full screen 

Minimize View » Minimize 

Quit Spycer » Quit Spycer 
Options » Config… Spycer » Preferences 
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8.3.2 The ’Spycer’/Spycer Icon Menu

The menu Spycer contains the following menu options:

Figure 8-13: The ’Spycer’ menu

In fullscreen mode (see section “Full screen” on page 8-19) the menu 
Spycer will be replaced by the Spycer icon (Linux and Windows only). 
However, then it still provides the same menu options as the menu 
Spycer shown in the figure above and detailed in the following.

Full screen

Select the menu option Full screen to activate the fullscreen mode of 
Spycer. In fullscreen mode the menu Spycer will be replaced by the 
Spycer icon (Linux and Windows only) but still provides access to the 
same menu options.

Tools » Calculator… Tools » Calculator 
License Man-
agement » 

Request… Tools » License Management » 
Request… 

Update… Tools » License Management » 
Update… 

License 
Server… 

Tools » License Management » 
License Server… 

View » Reset Layout View » Reset Layout 
Maximize Preview Area View » Maximize Preview Area 

Help » About Spycer » About Spycer 
Manual (html) Help » Manual (html) 
Manual (pdf) Help » Manual (pdf) 

Location on Linux/Windows Location on Mac OS
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Figure 8-14: Spycer icon providing the same menu options (Linux/Windows)

Minimize

To access other programs that are installed on your system when Spycer 
runs in the fullscreen mode, click the Minimize menu option on the 
menu Spycer. It reduces the Spycer user interface to a button on the 
taskbar of the operating system.

Quit

The menu option Quit exits the Spycer user interface. Further details 
about this can be found in section “Exiting the Software” on 
page 3-23.

8.3.3 The ’Options’ Menu

The Options menu provides a menu option to set up and configure the 
Spycer application. It contains the menu option as shown below:

Figure 8-15: The ’Options’ menu

It will be described in the following.

Config…

With the menu option Config… you can access the general configura-
tion settings of the Spycer application. You can find further information 
about them in section “Configuring Spycer” on page 8-4.

8.3.4 The ’Tools’ Menu

On the Tools menu you can find several tools to facilitate the usage of 
the Spycer application. It provides the following menu options:



8-21

2

1

3

4

Miscellaneous

I

A

6

7

5

8

Figure 8-16: The ’Tools’ menu

They will be described in the following.

Calculator…

With the calculator of Spycer you can calculate from an adjustable set-
ting of video formats its maximum recording time (by a given amount 
of storage space) or the required storage (by a given duration of the 
video data). It is described in more detail in section “Calculator” on 
page 7-10.

License Management

The License Management menu option allows you to configure your 
connected dongle and its license(s). It opens a submenu with the fol-
lowing options:

Figure 8-17: Submenu of the menu option ’License Management’

The Request… and Update… menu options are used in case you have 
to update your local dongle, for instance, to enable new features or 
change an evaluation license to a non-expiring one. For details refer to 
section “How to Update the License on the Dongle” on page 2-13.

With the menu option License Server… you make a set of floating 
licenses available to other Spycers in a network. Further information 
about this and how to do it can be found in section “Floating License” 
on page 2-14.

8.3.5 The ’View’ Menu

With the menu View you can change the layout of the user interface in 
certain ways. It contains the following menu options:
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Figure 8-18: The ’View’ menu

They will be described in the following.

Reset Layout

In case you have changed the layout of the user interface, for example, 
by hiding areas (see section “Changing the Layout of the User Inter-
face” on page 3-22), it can be reset with this menu option. Then the 
layout of the user interface will be set to a default layout and all areas 
will be visible again.

Maximize Preview Area

This menu option performs the same operation as the Maximize menu 
option of the video overlay’s context menu in the preview area (see sec-
tion “The Video Overlay” on page 5-6), i.e. it maximizes the view on 
the preview area. To restore the layout you can use the menu option 
Reset Layout (see above) or the menu option Minimize on the con-
text menu of the preview area (see section “The Video Overlay” on 
page 5-6).

8.3.6 The ’Help’ Menu

You can get additional information about the Spycer application via the 
menu option of the menu Help. It contains the following menu op-
tions:

Figure 8-19: The ’Help’ menu

They will be described in the following.

About

You can receive further information about the Spycer software with the 
menu option About on the menu Help:
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Figure 8-20: The ’About Spycer’ window

In the opening window you can find, for example, the precise version 
number of the software or additional license information (e.g. the serial 
number of the dongle or the expiration date and time). The latter may 
be useful to troubleshoot license issues.

Manual (html)

The documentation of the Spycer application can be accessed via the 
menu option Manual (html) on the Help menu. It opens the documen-
tation in HTML format

Manual (pdf)

The documentation is also available in PDF format which is most suited 
if you want to print out the document. It can be accessed easily via the 
menu option Manual (pdf).

The documentation in PDF format can also be opened from the 
manual in HTML format with the navigation buttons at the 
bottom of each page.
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8.4 Maintenance

The Spycer application, especially when working in a network, is a com-
plex set of individual programs. Because of this DVS provides some 
maintenance tools which will help you in the event of service and main-
tenance work. All the software programs described here are available 
for this purpose only. In your daily work with Spycer they should be of 
no use.

8.4.1 The SpycerAgent Tool

When a local content management is enabled, the SpycerAgent will be 
the most important part of the Spycer application. It is a process (Mac/
Windows: service, Linux: daemon) running in the background of your 
system and administering the local data and its database.

To administer the background process DVS offers you under all operat-
ing systems the SpycerAgent tool. Furthermore, under Linux and Mac 
operating systems you can also administer the SpycerAgent via a script.

The SpycerAgent Tool

With the SpycerAgent tool DVS offers you under all supported operat-
ing systems a graphical user interface to administer the background 
process. It can be started by performing the following:

This will start the SpycerAgent tool:

Before applying anything of the following please refer to sec-
tion “Troubleshooting” on page A-2 to see whether it is really 
necessary.

Further information about the SpycerAgent can be found in 
section “SpycerAgent” on page 2-6.

Linux: Call up a command line (shell) and enter 
SpycerAgentTool.

Mac: Select from the Applications folder of Mac OS 
the entry SpycerAgentTool.app.

Windows: Select from the START button menu of Windows in 
the submenu DVS the entry Maintenance.

From the opening submenu select the entry for the 
SpycerAgent tool (for example, All Programs » 
DVS » Maintenance » SpycerAgent Tool).
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Figure 8-21: The SpycerAgent tool

With the SpycerAgent tool you can control the SpycerAgent and, for in-
stance, start or stop it.

It provides the following items:

The standard operating system tools to administer a back-
ground process can be used as well to control the SpycerAgent.

Linux and Mac only: The files IP.conf and Service.conf 
(see section “Interesting Files and Folders” on page A-10) are 
configuration files of the SpycerAgent. By restricting access to 
them you can deny other users the possibility to alter the IP or 
service/daemon configurations.

SpycerAgent This entry field states the path on your system to 
the background process as well as its file name. To 
select another SpycerAgent you can either enter 
another path/file name or use the button to the 
right ( ) to select one via the opening dialog 
window.

ADVANCED… This button provides the same functionality as the 
ADVANCED… button of the general configuration 
settings. For a description please refer to section 
“The Group ’General’” on page 8-7.

START After installing the background process (button IN-
STALL) it has to be started. This can be made with 
the START button. Afterwards it will be running on 
your system administering the data and database.

STOP Once the background process is started (button 
START), it can be stopped with this button. After-
wards it is no longer running and the connection to 
the SpycerNet will be lost. However, after a reboot 
it will be started automatically again. A stopping of 
the process will make the UNINSTALL button avail-
able.
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In the middle of the window the current state of the SpycerAgent is de-
tailed. However, when the SpycerAgent tool is running and the state of 
the background process changes in the meantime, it will not be noticed 
by the tool automatically. In this case you have to update the status 
message as well as the state of the window by pressing the key [F5] (re-
fresh). Any changes in the state of the SpycerAgent will be detailed by 
the status message and the state of the tool’s controls may change.

The SpycerAgent Script (Linux/Mac only)

Under Linux and Mac OS the SpycerAgent process can also be admin-
istered via a script. It can be called from any command line by entering:

With the SpycerAgent script you can control the SpycerAgent and, for 
instance, start or stop it.

INSTALL A background process must be installed before it 
can operate. This can be done with this button. 
When the SpycerAgent is installed, it will be started 
automatically during the loading of the operating 
system. To start it now the button START has to be 
pressed (available after an installation of the back-
ground process).

UNINSTALL To un- or deinstall the background process you 
may use this button. Afterwards it will no longer be 
started during the loading of the operating system. 
The button UNINSTALL will be available once the 
process is stopped.

Linux: /etc/init.d/spyceragent <command> 

Mac: /Library/StartupItems/Spycer/Spycer-
Agent <command> 

The standard operating system tools to administer a back-
ground process can be used as well to control the SpycerAgent.

The files IP.conf and Service.conf (see section “Inter-
esting Files and Folders” on page A-10) are configuration files 
of the SpycerAgent. By restricting access to them you can deny 
other users the possibility to alter the IP or service/daemon 
configurations.

To install or deinstall the background process use the Spycer-
Agent tool (see section “The SpycerAgent Tool” on 
page 8-24).
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The following lists the available commands (<command>) for the 
SpycerAgent script:

8.4.2 The CodeMeter Control Center

CodeMeter is another name for the dongle providing the license for 
your Spycer application (see section “License Issues” on page 2-11). It 
comes with a control center and web server application for a more de-
tailed configuration of the dongle.

The CodeMeter Control Center can be accessed by performing the fol-
lowing:

start When the SpycerAgent is installed as a background 
process, it can be started with this command. Af-
terwards it will be running on your system admin-
istering the data and database.

stop Once the background process is started, it can be 
stopped with this command. Afterwards it is no 
longer running and the connection to the Spycer-
Net will be lost. However, after a reboot it will be 
started automatically again.

restart This command stops the process and afterwards 
starts it again.

status With this command the current state of the 
SpycerAgent is returned, i.e. whether it is started or 
stopped.

Because the control center and the web server application 
configure the dongle as well as its network capabilities do not 
change any of their default configurations unless you are ab-
solutely sure about the outcome, or are instructed to by your 
distributor or the DVS service department.

The web server application by CodeMeter can be accessed 
from the user interface of the CodeMeter Control Center (but-
ton WEBADMIN).

You can get further information about the control center as 
well as the web server application via the help information 
which can be accessed once the user interface of the control 
center is displayed.

Linux: Select from the system menu of Linux the entry 
Utilities » CodeMeter Control Center.
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This will start the user interface of the control center for the dongle.

8.4.3 Gathering Diagnostic Information

To aid a debugging the Spycer application stores log files which detail 
the actions performed by and with the program. You may get asked by 
the DVS service department to send in these files as well as others in 
case you experience operation problems with Spycer.

To gather the diagnostic information DVS prepared a script that will 
gather all required files automatically. To run it you have to do the fol-
lowing:

This will execute the script gathering all diagnostic information that 
may help DVS to determine your problem in an archive file (such as 
*.zip). Under Windows the file will be saved on your desktop, while 
under Linux and Mac it can be found in the folder where the script was 
called. Afterwards perform the following:

Locate the archive file and send it to the e-mail address provided by 
the DVS personnel.

Once your mail is received, the DVS support team will evaluate the in-
formation and, if possible, provide you with a solution for your prob-
lem.

Mac: Select from the Applications folder of Mac OS 
the entry CodeMeter.app.

Windows: Select from the START button menu of Windows in 
the submenu CodeMeter the entry CodeMeter 
Control Center (for example, All Programs » 
CodeMeter » CodeMeter Control Center).

For further information about the log files see section “Inter-
esting Files and Folders” on page A-10.

Linux/Mac: Call up a command line (shell) and enter slc.

Windows: Perform one of the following:

– Access the installation folder of Spycer (usually C:\
Programs\DVS\Spycer) and double-click the 
file slc.bat.

– Open a command line and enter slc.bat.
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8.5 Command Line Operations

Some features of the Spycer application can also be controlled from a 
command line. They can be called by entering:

The following lists the available operations and commands that can be 
performed from a command line:

Spycer [[command] <parameter>] 

If Spycer is not already running when initiating a command 
from a command line, it will be started automatically and the 
operation will be carried out.

Paths to directories should end with a backslash (Windows) or 
slash (Linux/Mac).

Depending on the operating system the syntax (paths) will be 
case sensitive.

Entering the syntax with an invalid command (e.g. -help) will 
call up help information in the Spycer user interface.

Command/Parameter Operation

- none - Simply entering Spycer at a command line 
without any command or parameter will start 
Spycer.

<path> Browses to and selects the drive, directory, 
clip, or file indicated by <path>.

-copy <source> 
<destination> 

Copies the directory tree or file/clip indicated 
by <source> to a destination location (di-
rectory). The destination location must al-
ready exist.

-move <source> 
<destination> 

Performs the same as -copy but moves the 
data instead of copying.

-delete <path> Deletes the directory, clip, or file indicated by 
<path>.

-defrag <path> Defragments the drive, directory, clip, or file 
indicated by <path>.
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Appendix

This chapter provides further information about the Spycer application. 
First some information are given how to resolve irregularities that may 
occur when using Spycer. After that it lists the file formats supported 
and some interesting files and folders installed or created by Spycer.
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A.1 Troubleshooting

This section details some errors and their solution which may occur 
when using Spycer. First some general errors and solutions will be de-
tailed, followed by a special troubleshooting that may be necessary 
when installing Spycer under the Windows Vista operating system.

A.1.1 General Troubleshooting

The table below lists some errors that may occur during the operation 
of Spycer and details how to resolve them:

Error Cause Solution

Spycer runs as Spycer 
Basic although a dongle 
is connected.

Your license was avail-
able for evaluation rea-
sons only and has 
expired.

Get a new non-expiring license from DVS 
(see section “License Issues” on 
page 2-11).

The dongle has been 
plugged in after the user 
interface was started.

See section “How to Connect the Dongle 
to a Running Computer” on page 2-12.

Spycer runs as Spycer 
Basic although floating 
licenses are available.

The CodeMeter applica-
tion is not installed.

The CodeMeter application has to be in-
stalled on both ends, the system that dis-
tributes the licences and the systems that 
should receive them (see section “Installing 
the Software” on page 3-2).

No systems/folders are 
displayed in the directo-
ry trees of the browsing 
panes, i.e. neither are lo-
cal drives/folders dis-
played nor network 
systems/folders.

Spycer is configured to 
localhost and the local 
content management is 
disabled.

With Spycer running alter the network con-
figuration settings from localhost 
(127.0.0.1) to the IP address of the net-
work connection that is connected to the 
network and/or enable the local content 
management (see section “The Group 
’General’” on page 8-7).

The SpycerAgent is not 
running.

Either close and afterwards re-start the user 
interface of Spycer, or use the SpycerAgent 
tool to get the background process started 
(see section “The SpycerAgent Tool” on 
page 8-24).

Some network ports are 
closed.

Some network ports have to be free and 
available to connect successfully to the 
SpycerNet. Otherwise Spycer will be con-
fined to its localhost only (IP address 
127.0.0.1 has to be used). For further in-
formation about this please see section 
“Important Notes” on page 1-8.
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No network systems are 
displayed in the directo-
ry tree of a browsing 
pane.

The network/system 
combo box is set to dis-
play the drives/directo-
ries of the local system 
only.

Set the network/system combo box to 
Network (see section “The Directory 
Tree” on page 4-3).

There are no other Spyc-
ers running in the net-
work.

Either start or install Spycer on another sys-
tem connected to your network and con-
figure it for the SpycerNet accordingly (see 
section “Getting Started” on page 3-1).

The local Spycer is con-
nected to the wrong 
network or configured 
to localhost (127.0.0.1).

With Spycer running alter the network con-
figuration settings: Select the proper IP ad-
dress of the network port connected to the 
network where other Spycer applications 
are present (see section “The Group ’Gen-
eral’” on page 8-7).

Some network ports are 
closed. May be the 
cause when no local 
drives are displayed as 
well.

Some network ports have to be free and 
available to connect successfully to the 
SpycerNet. Otherwise Spycer will be con-
fined to its localhost only (IP address 
127.0.0.1 has to be used). For further in-
formation about this please see section 
“Important Notes” on page 1-8.

A network system is visi-
ble but provides no data.

The appropriate permis-
sions are not given.

The system takes part in the SpycerNet as 
well as performs a local content manage-
ment but browse and search permissions 
are not given. Allow at least a browsing and 
searching on the system (see section “The 
Group ’Permissions’” on page 8-13).

A contents area of the 
browse and search tools 
does not show the de-
sired material.

The required data is not 
stored in the selected di-
rectory.

Move, copy or capture the required data to 
this directory.

The selective view com-
bo box is set to a selec-
tive viewing.

Set the selective view combo box to the 
kind of data that you want to display or to 
All Files (see section “The Status Bar” 
on page 4-9).

Some files (e.g. *.mov) 
require the installation of 
third-party programs. 

Install the third-party program (see section 
“System Requirements” on page 1-7) such 
as the QuickTime player.

Error Cause Solution
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A.1.2 Troubleshooting under Windows Vista

When running Spycer under the Windows Vista operating system, 
some particularities have to be observed:

You receive an error 
message when copying 
(moving) data.

You tried a copying be-
tween different systems 
in the network.

For copy procedures the Spycer application 
running on the foreign system must be set 
to the appropriate access rights (read per-
missions). Otherwise a copy process will 
not be possible. Set the access permissions 
of the Spycer application on the other sys-
tem appropriately.

You tried to copy/move 
data to a specially se-
cured location (e.g. on 
an SNFS storage).

Access to storage locations may be restrict-
ed. To enable accesses of the SpycerAgent 
to these locations you have to enter the ad-
ministrative access permissions via the AD-
VANCED… button available in the watch 
folder configuration settings (see section 
“The Group ’Watch Folders’” on 
page 8-15).

To troubleshoot license issues the ’About Spycer’ window 
provides further details about the license currently assigned to 
your application (see section “About” on page 8-22).

1. After installing Spycer you have to manually free the network 
ports to connect successfully to the SpycerNet in the installed fire-
wall (see section “Important Notes” on page 1-8).

2. If you experience problems with Spycer (e.g. some configuration 
settings are not available to configure the application), try to run 
it as the administrator:

If appropriate close the Spycer user interface.

Call up the context menu of the Spycer icon on the desktop of 
Windows (right mouse button).

Select the menu option Run as administrator.
This will run the Spycer application with administrator rights.

Error Cause Solution
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A.2 Supported File Formats

Spycer supports over 100 graphic and image file formats. Most are 
made available by a special library. For a list of all these file formats see 
http://perso.orange.fr/pierre.g/xnview/
enformats.html.

The tables in the following list the file formats that are supported by 
Spycer directly. They are listed according to their file types: First the vid-
eo file formats are detailed, then the audio file formats and last but not 
least a list of all other file formats supported by Spycer is given.

To be displayed in Spycer some file formats, such as the *.mov 
file format, may require the installation of third-party programs 
(e.g. the QuickTime player, see section “System Require-
ments” on page 1-7).

Table A-1: Supported video file formats

Format 
Name

Default
Extension

File storage 
format

Description

BMP *.bmp 3 × 8 bit RGB Windows bitmap format. Only un-
compressed bitmaps are supported 
(no RLE compression).

Cineon *.cin 3 × 10 bit RGB 10 bit RGB format. Subset of the 
ANSI/SMPTE DPX file format. Flexible 
file format by Kodak, allowing for 
variable image headers.

DPX *.dpx 3 × 8 bit RGB 
and 4 × 8 bit 
RGBA

8 bit RGB file format with or without 
key. SMPTE Standard File Format for 
digital moving-picture exchange.

8 bit YUV422 
and YUVA4224

8 bit YUV file format with or without 
key. SMPTE Standard File Format for 
digital moving-picture exchange.

3 × 10 bit RGB 
and 4 × 10 bit 
RGBA

10 bit RGB file format with or without 
key. SMPTE Standard File Format for 
digital moving-picture exchange.

10 bit YUV422 
and YUVA4224

10 bit YUV file format with or without 
key. SMPTE Standard File Format for 
digital moving-picture exchange.

3 × 12 bit RGB 12 bit RGB file format. SMPTE Stan-
dard File Format for digital moving-
picture exchange.

3 × 16 bit RGB 
and 4 × 16 bit 
RGBA

16 bit RGB file format with or without 
key. SMPTE Standard File Format for 
digital moving-picture exchange.

JPEG *.jpg 
*.jpeg 

3 × 8 bit RGB 8 bit RGB file format of the Joint Pho-
tographic Experts Group. Images are 
usually stored with lossy compression.

http://perso.orange.fr/pierre.g/xnview/enformats.html
http://perso.orange.fr/pierre.g/xnview/enformats.html
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JPEG2000 *.jp2 3 × 12 bit RGB 12 bit RGB file format. Flexible data 
and still image compression standard 
operating either compressed or un-
compressed.

3 × 16 bit RGB 16 bit RGB file format. Flexible data 
and still image compression standard 
operating either compressed or un-
compressed.

3 × 12 bit XYZ 12 bit XYZ file format. Flexible data 
and still image compression standard 
operating either compressed or un-
compressed.

QuickTime *.mov various (e.g. 
RGB or YUV 
either com-
pressed or un-
compressed + 
audio)

Video file format that supports various 
file storage formats, either com-
pressed or uncompressed. The whole 
video clip as well as audio are stored in 
one file only (container format). Pro-
prietary streaming video technology 
developed by Apple. 

SGI *.sgi 
*.rgb 

3 × 8 bit RGB 8 bit RGB file format. SGI IRIX image 
format.

3 × 16 bit RGB 16 bit RGB file format. SGI IRIX image 
format.

TGA *.tga 3 × 8 bit RGB 
and 4 × 8 bit 
RGBA, uncom-
pressed

Targa image format.

TIFF *.tif 
*.tiff 

3 × 8 bit RGB 
and 4 × 8 bit 
RGBA

TIFF or Tagged Image File Format in 
8 bit RGB with or without key. Highly 
flexible and platform-independent im-
age format. Not all variants of this for-
mat are supported by DVS.

3 × 16 bit RGB 
and 4 × 16 bit 
RGBA

TIFF or Tagged Image File Format in 
16 bit RGB with or without key. High-
ly flexible and platform-independent 
image format. Not all variants of this 
format are supported by DVS.

Table A-1: Supported video file formats (cont.)

Format 
Name

Default
Extension

File storage 
format

Description
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yuv *.qnt 
*.qtl 
*.yuv 
*.yuv8 

8 bit YUV422 
and YUVA4224

Raw 8 bit YUV422 and YUVA4224 
format.1 This file has no header. The 
image format is recognized by the file 
size. This is done with a table of pre-
defined file sizes. Component order 
UYVY.

*.yuv10 10 bit YUV422 
and YUVA4224

Raw 10 bit YUV422 and YUVA4224 
format. This file has no header. The 
image format is recognized by the file 
size. This is done with a table of pre-
defined file sizes. Component order 
UYVY. Bits are packed tightly from left 
to right for three component samples, 
then two bits of padding (zero) to fill 
up to four bytes. The lines are padded 
to a multiple of four bytes. The file is 
padded to a multiple of 512 bytes.

*.yuv16 16 bit YUV422 Raw 16 bit YUV422 format.2 This file 
has no header. The image format is 
recognized by the file size. This is done 
with a table of predefined file sizes. 
Each component is stored as a 16 bit 
value in big-endian byte order (left-
aligned). Component order UYVY.

1) 8 bit YUV422 and YUVA4224: 8 bit per component, 16 bit average per pixel
2) 16 bit YUV422 and YUVA4224: 16 bit per component, 32 bit average per 

pixel

Table A-2: Supported audio file formats

Format Name
Default

Extension Description

aif
aiff

*.aif 
*.aiff 

Audio interchange format. Platform-inde-
pendent file format for sound. Capable of 
storing multiple mono or stereo channels.

BWF *.rf64 Broadcast wave format. Platform-indepen-
dent file format for sound. Extension of the 
*.wav format capable of storing multiple 
mono or stereo channels and enabling file 
sizes of more than 4 GB.

RIFF wave *.wav ’Resource Interchange File Format’ (RIFF) 
for digital audio (waveform) data under 
Windows. Capable of storing multiple 
mono or stereo channels.

Table A-1: Supported video file formats (cont.)

Format 
Name

Default
Extension

File storage 
format

Description
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Table A-3: Other supported file formats

Format Name
Default

Extension
Description

3D LUT *.3dl 
*.e3d 
*.lut 

Three dimensional look-up table. ASCII file 
containing a matrix of color values to map 
them to a selected set of other values, e.g. 
for color conversion or gamma correction.

Project file of 
DVS video sys-
tems

*.cp DVS proprietary XML file format detailing 
all features of a timeline created with the 
DVS software on a video system by DVS 
(such as CLIPSTER or the Pronto2K.2).
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A.3 Keyboard Shortcuts

For a more easy control of Spycer there are various keyboard shortcuts 
available which are listed in the table below:

Action Key Action

Refresh the view of the directory 
tree (must have focus)

[F5]

Switch to the search tool of Spycer [Ctrl + F] (Mac: [ + F])

Play of material in preview area [Space], [5]

Stop of material in preview area [Space]

Step one (1) frame forward on a 
scrub bar (must have focus)

[Right Arrow], [4]

Step one (1) frame backward on a 
scrub bar (must have focus)

[Left Arrow], [3]

Step ten (10) frames forward on a 
scrub bar (must have focus)

[2]

Step ten (10) frames backward on a 
scrub bar (must have focus)

[1]

Select several items (e.g. files) dis-
jointedly

Hold [Ctrl] key (Mac: [ ]) while 
selecting with the mouse

Select a range of adjoining items 
(e.g. files)

Hold [Shift] key while selecting 
with the mouse

Within the home system: Move 
material to another location instead 
of copying

Hold [Alt] key while drag and 
drop with the mouse

Copy selected material to the clip-
board

[Ctrl + C] (Mac: [ + C])

Paste from clipboard to the selected 
position/location

[Ctrl + V] (Mac: [ + V])

Delete directories/files from the 
storage

[Del]

Close an open window of the Spyc-
er application

Linux/Windows only: [Alt + F4]

Exit Spycer [Alt + F4] (Mac: [ + Q])

Open the configuration settings Mac only: [ + ,]

Minimize Mac only: [ + M]

Open the online help [F1] (Mac: [ + Shift + ?])
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A.4 Interesting Files and Folders

The Spycer application is programed with the best know-how DVS has 
to offer in the field of digital video. It provides some files and folders 
that may be of interest to the user and/or the system administrator:

Leave the rest of the files in the directories mentioned in the 
following as they are. Do not try to run them if they are exe-
cutables or even delete them. This may cause harm to your 
computer system and/or the Spycer application installed.

Folder(s): log 

Location: Linux: /var/opt/DVS/Spycer/log 

Mac: /Library/Application Support/
DVS/Spycer/log 

Windows: C:\Documents and Settings\All 
Users\Application Data\DVS\
Spycer\log 

Condition: By default available.

Details: The files in this directory log the actions of the built-in de-
fragmenter (files Defrag-<timestamp>.log, see also 
section “Defragmenter” on page 7-4) and of the Spycer-
Agent (Agent-<timestamp>.log, see also section 
“SpycerAgent” on page 2-6). Only the last ten files of 
each log will be kept.

Folder(s): log 

Location: Linux: /home/<user>/.DVS/Spycer/log 

Mac: /Users/<user>/Library/Applica-
tion Support/DVS/Spycer/log 

Windows: C:\Documents and Settings\<us-
er>\Application Data\DVS\Spyc-
er\log 

Condition: By default available.

Details: When the Spycer user interface is started, a log file is 
written into this directory detailing all actions performed 
by and with the user interface. When exiting Spycer, the 
log file is finished and saved. Only the last ten files will be 
kept.
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Folder(s): proxies 

Location: Linux: /home/<user>/.DVS/Spycer/prox-
ies 

Mac: /Users/<user>/Library/Applica-
tion Support/DVS/Spycer/proxies 

Windows: C:\Documents and Settings\<us-
er>\Application Data\DVS\Spyc-
er\proxies 

Condition: Will be created after the first download of a proxy over 
the SpycerNet.

Details: This folder stores temporarily the proxies used for a pre-
view when a clip from a foreign system is singled out (see 
section “General Information about Proxies” on 
page 5-5).

File(s): Agent.cdb and Agent.cdb.bak (backup file)

Location 
when 
logged in 
as admin 
(root):

Linux: /var/opt/DVS/Spycer 

Mac: /Library/Application Support/
DVS/Spycer 

Windows: C:\Documents and Settings\All 
Users\Application Data\DVS\
Spycer 

Location 
when 
logged in 
as user:

Linux: /home/<user>/.DVS/Spycer 

Mac: /Users/<user>/Library/Applica-
tion Support/DVS/Spycer 

Windows: C:\Documents and Settings\<us-
er>\Application Data\DVS\Spycer 

Condition: Will be created when the local content management is 
enabled.

Details: The database administered by the SpycerAgent and its 
backup file. Can be deleted. However, then any virtually 
added metadata will be lost and the SpycerAgent will 
have to scan the watched folders again which may take 
some time and render the system busy. To initiate a new 
scan you may have to stop and start the SpycerAgent.
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File(s): Agent.conf, IP.conf, Service.conf 

Location: Linux: /var/opt/DVS/Spycer 

Mac: /Library/Application Support/
DVS/Spycer 

Windows: C:\Documents and Settings\All 
Users\Application Data\DVS\
Spycer 

Condition: Will be created when the local content management is 
enabled.

Details: Configuration files of the SpycerAgent. Do not delete.

Linux/Mac only: By restricting access to the files 
IP.conf and Service.conf to ’read only’ 
you can deny other users the possibility to alter 
the IP or service/daemon configurations.

File(s): SearchItems.xml 

Location 
when 
logged in 
as admin 
(root):

Linux: /var/opt/DVS/Spycer 

Mac: /Library/Application Support/
DVS/Spycer 

Windows: C:\Documents and Settings\All 
Users\Application Data\DVS\
Spycer 

Location 
when 
logged in 
as user:

Linux: /home/<user>/.DVS/Spycer 

Mac: /Users/<user>/Library/Applica-
tion Support/DVS/Spycer 

Windows: C:\Documents and Settings\<us-
er>\Application Data\DVS\Spycer 

Condition: By default available.

Details: Contains the parameters for a search in the search tool of 
the Spycer application. You may adapt it, for example, to 
change the sequence of search parameters in the drop-
down list of the very first combo box.

Do not alter this file any further. Otherwise the 
search tool may not operate correctly anymore.
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File(s): BrowserCore.data, BrowserGui.data 

Location: Linux: /home/<user>/.DVS/Spycer 

Mac: /Users/<user>/Library/Applica-
tion Support/DVS/Spycer 

Windows: C:\Documents and Settings\<us-
er>\Application Data\DVS\Spycer 

Condition: Will be created after the first closing of the user interface.

Details: These files store the layout of the user interface. They can 
be deleted without harm. However, then the program 
will start with a default layout. They will be created again 
when the program is exited.
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